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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user’s authority to operate this equipment.

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus meets all the requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de Conformation Classe B de I'Industrie Canada
Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le matériel brouilleur du Canada.

Certificate by Manufacturer/Importer

This is to certify that the FCO7 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
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Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FCO7 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.

Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen
ist der Betreiber verantwortlich.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE
ACCEPTED THE TERMS OF THIS AGREEMENT. If you cannot or do not accept these terms, you may return the entire package within ten (10) days to
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included
with the Fiery ZX you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.



You may:

a. use the Software solely for your own customary business purposes and solely with Fiery ZX;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery ZX in a special encrypted format (“Coded
Font Programs™) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own
customary business purposes on the display window of the Fiery ZX or monitor used with Fiery ZX;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery ZX provided the transferee agrees to be bound by
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces
for use other than with Fiery ZX;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as
necessary for use with the Fiery ZX unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made,
any copies of that certain portion of the Software which has been included on the Fiery ZX hard disk drive. You may not copy the documentation;

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font
Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic
termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning
Fiery ZX to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states
do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.



Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK.
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the
Typefaces and the Trademarks licensed hereby. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics
for Imaging.

General
This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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Preface

xiii

Copier and feature support

This manual is intended for Fiery ZX3300/2X3200 Color Server operators or
administrators, or users with the necessary access privileges, who monitor and manage
job flow, perform color calibration, and troubleshoot problems that may arise. It
describes the functions and features of Fiery utilities and Fiery WebTools for the
purposes of print job management and color quality control.

NoTe: The term “Fiery ZX” is used to refer to both the Fiery ZX3300 and
Fiery ZX3200 Color Server. Where appropriate, differences between the two are
noted.

Copier and feature support

The Fiery ZX supports R2 color copiers—the term “R2” refers to the following copier
models:

* Ricoh Aficio Color 5106 and 5206
Lanier 5606DC

* Sharp AR-C861 and AR-C862

* Gestetner 2606 and 2606e

* nashuatec C606 and C606e

» Rex Rotary CC8606 and CC8606E
« infotec 7316 and 7316E
» Savin SDC206 and SDC206E

The Fiery ZX3300 includes Command WorkStation™ software, which enables an
operator to manage all jobs sent to the Fiery ZX. Although it may not be the case at all
sites, the documentation for this product assumes the presence of an operator who
controls and manages jobs sent by users from remote workstations.

The Fiery ZX3200 does not include Command WorkStation software. However,
Command WorkStation hardware and software are both available options; contact
your authorized service technician for information.
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About this manual

This manual is organized as follows:

Chapter 1 describes the Fiery ZX Control Panel. It explains the various messages and
icons that you might see on the Control Panel and describes how to print system
information pages from the Control Panel. It also explains how to properly start up
and shut down the Fiery ZX.

Chapters 2 and 3 describe the Command WorkStation™ interface. The Command
WorksStation application can be installed on networked Windows NT 4.0
computers and used to view and manage virtually all aspects of Fiery ZX activity. In
addition to providing a graphic display of the job flow, the Command WorkStation
allows you to reprint or hold jobs, view and override print option settings, download
files, manage printer fonts, preview print jobs, merge rasterized jobs, calibrate the
Fiery ZX, and perform Setup (server configuration).

Chapter 4 introduces Fiery WebTools, explains how to access them, and directs you
to sources of more information (in this manual or in other manuals in the
documentation set).

Chapter 5 describes Fiery WebSpooler and Fiery Spooler, which can be used to view
and manage Fiery ZX job activity. The interface and features of Fiery WebSpooler
and Fiery Spooler have identical counterparts in the Command WorkStation;
therefore, this chapter refers you to Chapters 2 and 3 for details about many Fiery
WebSpooler and Fiery Spooler functions.

Chapter 6 tells you how to monitor and maintain color quality of your print output
by calibrating the Fiery ZX with Fiery Print Calibrator or AutoCal.

Chapter 7 describes advanced applications of Fiery Print Calibrator, such as creating
custom calibration and simulation targets to customize the color responses of the
Fiery ZX.

Appendix A lists error messages that you might see at the Fiery ZX Control Panel,
the Command WorkStation, Fiery WebSpooler, Fiery Spooler, or the copier, and
contains some troubleshooting information.
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Terminology

Specific terms are explained as they are introduced. However, the following general
terms are used throughout:

PostScript (PS)—A computer language designed as a page description language. The
Fiery ZX uses this language for imaging the page and for communication with
applications and with the print engine.

Job—A file consisting of PostScript commands and comments that describe the
graphics, sampled images, and text that should appear on each page of a document,
and the printer options that should be used in printing, such as media or color
rendering style.

Spool—Write to a disk. Usually used here to refer to a PostScript print job being
saved to the Fiery ZX hard disk in preparation for processing and printing.

RIP—Acronym for raster image processing, which changes text and graphics
commands into descriptions of each mark on a page. In common use as a noun, a
“raster image processor” (RIP) is the computer processor that performs this function.

Print—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery ZX3300/2X3200 Color Server and the
copier work together as a powerful printing system. The Fiery ZX PostScript RIP
changes text and graphics commands in PostScript into color specifications for each
dot of toner deposited on a page by the copier.

About the documentation

This manual is part of the set of Fiery ZX documentation, which includes the
following manuals for users and system administrators:

The Configuration Guide explains basic configuration and administration of the
Fiery ZX for the supported platforms and network environments. It also includes
guidelines for setting up UNIX, Windows NT, and NetWare servers to provide
PostScript printing services to clients.

Getting Started describes how to install software to enable users to print to the
Fiery ZX. Specifically, it describes installation of PostScript printer drivers, printer
description files, and other user software provided on the User Software CD and
Command WorkStation CD. It also explains how to connect each user to the
network.
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 The Printing Guide describes the printing features of the Fiery ZX for users who
send jobs via remote workstations on the network or via a direct parallel port
connection.

« The Color Guide provides an introduction to the basics of color theory and printing
to a Fiery ZX Color Server. It also includes practical color printing tips and
application notes that explain how to print to the Fiery ZX from popular Windows
and Mac OS applications.

« The Job Management Guide explains the functions of the Fiery ZX client utilities,
including the Command WorkStation, and how they can be used to manage jobs
and maintain color quality. This book is intended for an operator or administrator,
or a user with the necessary access privileges, who needs to monitor and manage job
flow, perform color calibration, and troubleshoot problems that may arise.

« Release Notes provide last-minute product information and workarounds for some of
the problems you may encounter.

Fiery ZX job environments

The Fiery ZX supports several levels of control of printing, job management, and
setup, and offers you the flexibility to choose the configuration that corresponds to the
requirements of your site. Your situation may correspond to one of the descriptions
outlined below, or you may prefer an intermediate level of control.

At one extreme, an administrator or operator in a high-volume printing environment
controls the entire job flow and all printing. Print jobs arriving from remote users are
spooled to the server disk and stored until the operator decides it is time to print them.
Additional functions (calibration, job overrides, prioritizing, font management) are
reserved for the administrator or operator.

At the other extreme, anyone on the local network can control all printing and server
functions; operator intervention is not necessary. Users can print from their
workstations to any of the published print connections. Anyone can use the Command
WorkStation, Fiery WebSpooler, or Fiery Spooler to control any print job.

The spectrum of control that an administrator can implement is described fully in the
Configuration Guide.
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Fiery ZX job environments

Permissions

Support for these job environments is achieved by a combination of Fiery ZX Setup
options. By default, anyone can access Setup, but the administrator can limit access to
Setup by specifying an Administrator password for the Fiery ZX (see the Configuration
Guide).

Also by default, anyone can log in to the Command WorkStation, Fiery WebSpooler,
or Fiery Spooler and control job flow, but an administrator can restrict access to these
functions by specifying an Operator password.

The three security levels from greatest to least control are:

 Administrator—confers control of Setup and is the highest level of control. The
person who has access to Setup can control the printing and job management
environment by choosing which queues are enabled, and by electing to set
passwords. The Administrator can also manage the fonts on the server, clear the
server disk when necessary, and set a common web link for all users who log in to the
Fiery ZX using their web browser.

 Operator—includes control of print jobs that arrive at the server and the ability to
perform calibration and reboot the server.

 Guest—allows users to view the status of active jobs and the list of stored jobs. They
cannot make changes to jobs. A password is not needed to log in as Guest and view
jobs from the Command WorkStation, Fiery WebSpooler, or Fiery Spooler
windows.

This manual describes the features of the Fiery client utilities, including the Command
WorksStation, and all operator privileges, whether those privileges are available to
everyone or are exclusive to only certain people. It also includes descriptions of
administrator functions, sometimes referring you to other manuals for more
information.
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Safety warnings

The Fiery ZX display window is a liquid crystal display (LCD) that is made of glass
and can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale,
ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap
and water immediately.

Do not touch or put pressure on the panel. This will change the color of the panel.

Cleaning the Fiery ZX

Clean the Fiery ZX with a soft cloth moistened with isopropyl alcohol or ethyl alcohol.
Never use water or ketone as these may permanently alter the display.
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Ch apter 1: You can use the Fiery ZX Control Panel to view status information, print special pages,
Using the and set up printing. While most elements in the Control Panel display have

counterparts in the Command WorkStation, you can view current functions on the
Control Panel Control Panel even when the Command WorkStation is not connected to the server or
is not running.

Introduction to the Fiery ZX Control Panel

The Control Panel, shown below on the front of the Fiery ZX, comprises the following

parts:
_/?\r
o
Activity light
12 : :
< Line selection buttons
Display window _§
@J Up and down buttons
Menu button

Behind CD-ROM door
CD-ROM drive for installing
system software

(for service technician only)

/] N
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Activity light
The activity light indicates the current Fiery ZX activity. If the light is:

Solid red An error has occurred causing the Fiery ZX to be disabled.

Flashing red There is an error causing printing to be disabled, but the
Fiery ZX is capable of processing.

Solid green The Fiery ZX is idle.

Flashing green The Fiery ZX is processing or printing a job, or
communicating with a remote computer.

No light The Fiery ZX is off or starting up.

Buttons

Line selection There are four line selection buttons on the right side of the
buttons Control Panel. Use these buttons to select the command

displayed on the corresponding line of the display window.
When a button is active, a special character (>) appears in the
display window next to the button.

Up and down Use these buttons to scroll to different screens in multi-
buttons screen lists, to select Setup options from a list of available
options, and to scroll alphanumeric characters.

Menu button Press this button to view other screens. Under normal
operation, the Control Panel displays the Info, RIP, or Print
Status screen with information about the status of the
Fiery ZX. If you press the Menu button, the Functions menu
is displayed and you can perform additional operations (see
page 1-5). If a job is processing or printing, press the Menu
button to cycle among the active screens.
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Display window

The display window provides information about the status of the Fiery ZX, displays
menu information, and enables you to view and edit information in the Setup menus.

The last line of the display window displays text that tells you what screen you are
looking at and highlights one of the icons to indicate what the Fiery ZX is doing. Only
the icons for the screens that are currently available appear. The menu button cycles
among the active screens.

The screens are:

If there is a problem with processing a job or printing functions, an error message
appears on the Control Panel. For information on error messages, see Appendix A,
“Troubleshooting.”

When the Fiery ZX is printing a job, the Print Status screen appears. This screen
displays the following:

Cancel Job—Press the top line selection button to cancel the job currently
printing.

User name—The name of the user who sent the job currently processing.

Pages/Total—The number of copies of the current job printed and the total
number of copies of the job requested.

When the Fiery ZX is processing a job, the RIP Status screen appears. This screen
displays the following:

Cancel Job—Press the top line selection button to cancel the job currently
processing. The Fiery ZX cancels the job before printing begins.

Document name—The name of the document currently processing.
User name—The name of the user who sent the job currently processing.
Kilobytes—The size (in kilobytes) of the job processed so far.

Note: This number is always displayed in kilobytes, even if the amount goes over
1000KB; for example, 10MB is displayed as 10000KB.
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When the Fiery ZX is not processing or printing a job, it displays information
about the current server and software. It displays the following information:

Server Name—The Fiery ZX name.

Status—T he current status of the Fiery ZX. The Fiery ZX status can be: Idle,
Initializing, Busy, Processing, or Printing.

Megabytes—T he space (in megabytes) available on the Fiery ZX hard disk, for
example, 756 MB.

Version—T he system software version running on the Fiery ZX.

You can press the Menu button to display the Functions menu. Use the up and
down buttons to scroll through the list. Press the line selection button to the right
of a command to select that command. See page 1-5 for more information.

The network icon appears at the bottom left of any of the other screens when a
job is being sent to the Fiery ZX, either over the network or through the parallel
port. The network icon also appears, together with a flashing green activity light,
when a remote utility is running.
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Functions menu

The Functions menu provides many of the options available from the Command
WorksStation. You can choose the following commands from this menu:

Print special pages from the Fiery ZX. You can print the following pages from the
submenu that appears:

Test Page—A Test Page enables you to confirm that the Fiery ZX is properly
connected to the copier, and provides color and grayscale samples to troubleshoot
problems with the copier or the Fiery ZX. The following settings are among those
listed on the Test Page: Server Name, Printer Model, color settings, calibration
information, date and time the Test Page was printed.

Configuration—Prints the Configuration page, which gives the current server and
device configuration. This page lists general information about the hardware and
software configuration of the Fiery ZX, the current options for all Setup settings,
information about the current calibration, and the Ethernet and Token Ring
addresses of the Fiery ZX.

Job Log—Prints a log of the last 55 jobs. For information on the fields in the Job
Log and on printing it in other forms, see “Job Log window” on page 2-25.
Control Panel Map—Prints the Control Panel Map, which is an overview of the
screens you can access from the Control Panel. For information about using these
screens to set up the Fiery ZX, see the Configuration Guide.

Color Charts—Prints samples of the RGB, CMY, and PANTONE colors available
from the Fiery ZX.

Font List—Prints a list of all fonts currently on the Fiery ZX hard disk.

Suspend communication between the Fiery ZX and the copier. You must suspend
printing if you want to interrupt the current Fiery ZX job so that you can use the
copier to make copies. Jobs continue to process on the Fiery ZX. After you make
the copies, select Resume Printing to continue printing jobs from the Fiery ZX.

Resume communication between the copier and the Fiery ZX after you have
finished making copies.

This function is provided for service representatives only. Contact your authorized
service/support technician for information about running diagnostics.

Shut down all Fiery ZX activity in the correct manner and then restart. You
should use this option instead of the power switch on the back of the Fiery ZX.
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Starting and shutting down the Fiery ZX

Generally, you can leave the Fiery ZX running all the time. This section describes how
to shut down and restart the Fiery ZX when necessary.

Starting the Fiery ZX

To start the Fiery ZX, move the power switch on the back of the Fiery ZX to the On
position. If the copier is also powered off, power it on before powering on the
Fiery ZX.

Power switch

Diagnostic messages appear on the Fiery ZX Control Panel. If any diagnostics fail,
more information and instructions appear. Contact your service representative if the
Fiery ZX encounters problems while running the diagnostics.

When the diagnostics are finished, the following message is displayed:

Press any key for setup...

If you want to change Setup option settings, press any button; if you do not press a

button, the Fiery ZX continues starting up and displays the message Idle when it is
ready to receive data.

Note: If an Administrator password has been set, you are required to enter it to access
Setup.

If you press a button, the following options appear.
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For information about the Setup menus and options, see the Configuration Guide.

Choose: To do this:

Exit Setup Exit the Setup menus; the Fiery ZX reboots.

Server Setup Enter the Server Setup menus.

Network Setup Enter the Network Setup menus.

Printer Setup Enter the Printer Setup menus.

PS Setup Enter the PostScript Setup menu.

Color Setup Enter the Color Setup menu.

Job Log Setup Enter the Job Log Setup menu.

Calibration Calibrate the Fiery ZX using AutoCal or a densitometer. For

more information, see “Calibrating from the Control Panel”
on page 6-20 and the Configuration Guide.

Change Password Change the Administrator password.

Clear Server Clear all jobs in all server queues as well as the Job Log.
Check with your administrator or operator before choosing
Clear Server.

Restarting the Fiery ZX

You should use the procedure described below to restart the Fiery ZX rather than using
the power switch on the back of the Fiery ZX.

TO RESTART THE FIERY ZX:

1. Make sure that the Fiery ZX is not receiving, processing, or printing a job.

Make sure that the status message on the Control Panel is Idle.

Note: If a job from the Print queue is processing, it will continue processing and print
after the Fiery ZX is restarted; if a job sent to the Direct connection is processing, it
will not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the down button to scroll to the last screen and choose Reboot Server.
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Shutting down the Fiery ZX

You may need to shut down the Fiery ZX for service. When you do so, fonts that have
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and
Printed queues and jobs that have been processed but not printed are not deleted and
are available for printing when you restart the Fiery ZX.

TO SHUT DOWN THE FIERY ZX:

1.

Make sure that the Fiery ZX is not receiving, processing, or printing a job.

Make sure that the status message on the Control Panel is Idle. If a job has just finished
processing or printing, wait at least five seconds after the Control Panel status message
switches to Idle before proceeding to step 2.

Norte: If a job from the Print queue is processing, it will continue processing and print
after the Fiery ZX is restarted; if a job to the Direct connection is processing, it will not
finish processing or printing.

Power off the Fiery ZX by moving the power switch on the back to the Off position.

Note: After powering off the Fiery ZX, make sure to also power off the copier. Leaving
the copier powered on while the Fiery ZX is powered off can lead to excessive drain on
the Fiery ZX motherboard battery.
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This chapter introduces you to the graphical user interface of the Command
WorkStation. First, you select a user level and log in to the Fiery ZX. Once you have
logged in, you can tour the Command WorkStation windows. Your exploration will be
more complete if you have some jobs in the Spool area (jobs printed to the Hold
queue) and have the ability to send more jobs from a nearby computer.

Chapter 3 builds on the information in this chapter and describes job monitoring and
control in more depth.

About the Command WorkStation

The Command WorksStation provides a window on Fiery ZX and copier functions,
and an interface from which you can control those functions. The Command
WorkStation application can be installed on a Windows NT 4.0 computer with a
TCP/IP network connection to the Fiery ZX.

By default, no passwords are set on the Fiery ZX—in this default state, anyone can
perform Setup and use all Command WorkStation functions. Until an Administrator
password is defined in Fiery ZX Setup, you can log in to the Command WorkStation
as an Administrator without entering a password, and you are given full privileges
which include:

A view of current printing jobs and jobs stored on the Fiery ZX
 Control of printing jobs and calibration

* Access to Setup, management of resident fonts, and clearing of the Fiery ZX disk
and the Job Log

After the Administrator has performed Setup and specified passwords, Command
WorkStation user options depend on your login level. If you log in to the Command
WorkStation as Guest, you have the first option only. If you log in as Operator, you
have the first two options. If you log in as Administrator, you have all three options.
For information about Setup and specifying passwords, see the Configuration Guide.
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After you connect to a Fiery ZX and log in, your first view of the Command
WorksStation is the Queues window (as indicated by the tab at the bottom) which is
divided into three regions by Spool, RIP, and Print status bars. The Queues window is
surrounded by a frame that includes slider buttons and menus.

Once the Fiery ZX receives print jobs, the Queues window becomes a dynamic display,
filled with the names of jobs and their characteristics. Status bars animate in real time
as new jobs are processed and printed, and jobs move to different display areas. An
operator, who has complete job control, sets the process in motion for each job.

Menu bar

Spool status bar

Spooled jobs

RIP status bar

Rasterized (RIPped) jobs

Print status bar

Printed jobs
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The Spool, RIP, and Print areas of the Queues window represent the stages of printing
a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless
they are held along the way.

* Spooled jobs—Jobs listed below the Spool status bar area are PostScript files stored
on the Fiery ZX disk. These jobs were sent to either the Print queue (white icons) or
the Hold queue (yellow icons).

« RIPped jobs—1Jobs listed below the RIP status bar are ready to print. They have
already been rasterized (RIPped, or processed for printing) and are waiting, in order,
for access to the printer. Rasterized jobs can also be held; held jobs are displayed on a
yellow background.

* Printed jobs—1Jobs listed below the Print status bar have already been printed.
Printed jobs can be stored on the Fiery ZX disk. The number of jobs that can be
stored (from 1 to 99) is defined in Setup.

You can interact with a jobs in the window by selecting them and choosing from Job
menu commands or right-mouse menu commands, or by double clicking them.
(However, if passwords have been set and you log in as a Guest, you can only view jobs;
you cannot change or route them.) This chapter and the next explain the Command
WorkStation interface in detail.

Starting up and logging in

To start up the Command WorksStation application, click the Windows Start button
and choose Command WorksStation from the Programs menu.

Connecting to the server

If the Command WorksStation was previously connected to a server, you are prompted
to choose a Fiery ZX from the list of servers.

Note: If the Command WorkStation has never been connected to a Fiery ZX, you are
prompted to configure an entry for the server. Click OK and see Getting Started for
instructions on how to configure a new connection.
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With the Fiery ZX device name (r2) selected, click OK. If the device name is not
displayed, click the plus sign (+) to expand the Fiery ZX entry.

The Command WorkStation connects to the server and you are prompted to choose a
login level and enter a password to log in (see below).

If you have any difficulties connecting to the server, see Appendix A for error messages
and troubleshooting information.

Logging in

When the Command WorkStation has connected to a server, the Log in/out slider
appears, prompting you to select a login level and enter a password. Before you log in,
the Operator key is in the vertical position, and the Administrator and Guest keys are
in the flat (horizontal) position. When you click your login level, the corresponding
key turns to the vertical position.

Log in/out slider
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For Administrator or Operator access to the server, click the corresponding key, enter
the password, and click Log in or press Enter. For Guest access only, click the Guest
key and then click Log in. No password is required for Guest access.

If you change your mind about logging in, or do not have the password you need, click
Cancel.

When you have entered the appropriate password and logged in, the Log in/out slider
retracts and the full Command WorkStation display appears. The color of the key in
the lock indicates your login level. If the server is handling a large number of jobs, it
may take a few moments to display the entire job list.

When you reopen the slider after you have logged in, the Log in button will have
changed to the Log out button.

Access levels

The three possible levels of access to Command WorkStation functions are
Administrator, Operator, and Guest. To enable maximum password protection,
Administrator and Operator passwords must be specified in Setup (see the
Configuration Guide).

When both Administrator and Operator passwords have been specified, the access
levels are as follows:

Access level: Privileges and password requirements:

Administrator Has full access to all Command WorksStation and Fiery ZX
Control Panel functions; Administrator password required

Operator Has access to all Command WorkStation functions except Setup,
clearing the server disk, clearing the Job Log, and font
management; Operator password required

Guest Can view job status, but cannot make changes to jobs or Setup,
and cannot view the Job Log; no password required
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Note: Access privileges alone do not confer control of print jobs. If the operator is
going to manage all print jobs, the Administrator must route all user jobs to the Hold
queue (that is, all jobs are spooled and held on the server). To accomplish this, only the
Hold queue, and not the Direct connection or the Print queue, should be enabled in
Setup. See the Configuration Guide for more information.

Logging out
There are two ways to log out from the server:
 From the Server menu, choose Log out

« Open the Log in/out slider (click the key icon just below the Fiery logo) and click
Log out

o )T e ——

The Command WorkStation interface

The display illustrated below is the default Command WorksStation display in the
middle of job processing. It shows the elements common to all Command
WorkStation displays (1 through 4) and the Queues window elements (5 through 8).
There is another window, Job Log, which you access with a tab at the bottom of the
display (3). However, the Queues window is the one from which most Command
WorkStation operations are performed.
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1 Server selection tabs

2 Sliders and system information
3 Window selection tabs

4 Job ticket information

5-8 Queues window display

The Command WorkStation provides access to a great deal of information and many
features that are accessed in various ways—buttons, menus, double-clicking, and right
mouse commands. It is a powerful interface that allows for a great deal of interaction
and flexibility in the production process. This section describes each of the elements
that compose the Command WorkStation display.
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Window area (Queues, Job Log)

This area can display one of two windows: the Queues window (shown below), or the
Job Log window (the Job Log window is not available if you logged in as Guest). The
Queues window is the default window; it shows spooled, processing, and printing jobs
in a display that changes dynamically.
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For information on this window area: See:

Queues “Queues window” on page 2-15

Job Log “Job Log window” on page 2-25
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Menu bar

The menu bar has five menus. When an action is not available in the current context,
the command is dimmed. When a command is marked with a check, selecting it again
reverses, or toggles, the command.

& Command WorkStation
File Job Page Serer Help

Menu: Choose this: To do this:

File Preferences> Turn on or off animation of the status bars
Enable Animation

Preferences> Turn on or off short captions that appear when you pause the mouse over
Enable Popup Help window elements. The captions identify the main parts of the Command
WorkStation window.

Preferences> Expand the status bars to make them more visible from a distance, or collapse
Expand/Collapse All | them to free up window space

Preferences> Restore default settings for the status areas (narrow heights), the column
Revert to Defaults headings (job title, user, date/time, copiers, size), and the column widths
Print Pages Print any or all of the following pages: Configuration page, Test Page, Control

Panel Map, Font List, Color Charts, Job Log; see page 3-3

Exit Log out from the server, exit the Command WorkStation application, and
return to the Windows desktop




2-10 | Introduction to the Command WorkStation

Menu: Choose this: To do this:
Job Delete Delete one or more selected jobs
(For more - - : . :
information on Duplicate Duplicate one or more selected PostScript data jobs in the Spool or Print areas,
these commands, see page 2-19, page 2-21, and page 2-22
see page 2-22) Rename Rename a selected job
Hold Hold the selected job(s); see page 2-17
RIP and Hold RIP and then hold the selected job(s); see page 2-17
Print Print the selected job(s); see page 2-21

Print and Hold

Print the selected job(s) and then hold it in the RIP area; see page 2-17

Process Next

Give top priority to this job

Remove Raster

Remove the raster information from the selected job(s); see page 2-23

Properties View and edit print settings for the selected job(s); see page 2-27
Thumbnail A Open a selected held raster data job in the Thumbnail A window where you
can view a full-screen preview of the job, edit the job, or merge it with raster
data from other jobs; see page 2-28
Thumbnail B Open a selected raster data job (not necessarily a held job) in the Thumbnail B
window for viewing or for copying pages into a job in the Thumbnail A
window; see page 2-29
Download Download files and fonts to the Fiery ZX with Fiery Downloader; see
page 3-16
Page Delete Delete the selected page(s)
(DocBuilder X X
commands for Duplicate Duplicate the selected page(s)
Thumbnail A) Preview View a full-screen preview of the selected page; see page 2-31
Undo Undo previous Page menu commands (multiple undos available)
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Menu:

Choose this:

To do this:

Server

Cancel RIPping

Stop RIPping the current job

Cancel Printing

Stop printing the current job

Suspend Printing

Temporarily halt printing

Resume Printing

Restart printing (after a Suspend Printing command)

Calibrate

Start the Fiery Print Calibrator; see Chapter 6 and Chapter 7

Manage Fonts

View the fonts currently installed on the Fiery ZX disk, download additional
fonts, or delete fonts (requires Administrator privileges); see “Server
management commands” on page 3-23

Reboot Perform a soft reboot of the Fiery ZX (requires Operator or Administrator
privileges); see “Server management commands” on page 3-23

Clear Clear all jobs in all queues on the Fiery ZX hard disk as well as the Job Log
(requires Administrator privileges); see “Server management commands” on
page 3-23

Setup Start the Fiery Setup program (requires Administrator privileges); see “Server
management commands” on page 3-23 and the Configuration Guide

Log out Log out of the server

Help About View the Command WorkStation information screen
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Server selection tabs

The Server selection tabs, just below the menu bar at the top of the display, can be used
to log in to additional Fiery ZX servers (if your site has more than one) and to switch
between Fiery ZX servers currently connected to the Command WorksStation.

If you click a blank tab, you are prompted to connect to a server in the list or configure
a new server entry (see “Connecting to the server” on page 2-3). A limit of five
Fiery ZXs can be connected to a single Command WorkStation.

You can access the Server selection tabs from both Command WorkStation windows
(Queues and Job Log).

Sliders
Along the left side of the display are buttons you click to activate function sliders.

[ job

Click to view server information

Click to open the Log in/out slider

Click to start a Fiery utility

Click to view disk space and :ﬁ
RAM availability =

To retract any slider, click the icon at the far right of the slider.
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Server information slider
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The Server information slider displays name and version information about the
currently connected server and the Command WorkStation. To retract the slider, click
the Fiery logo at the far right of the bar.

Log in/out slider

This slider is described in “Logging in” on page 2-4 and “Logging out” on page 2-6. To
retract the slider, click the lock icon at the far right of the bar.

Utilities shortcut slider

L e i 1 el

This slider can be used to access the Fiery Downloader and Fiery Print Calibrator
utilities. These utilities can also be accessed from the Job menu and Server menu,
respectively. To retract the slider, click the icon at the far right of the bar.

Disk space and RAM slider

Disk space used

tH] [l

I 20

RAM currently in use

Total RAM Total hard disk capacity

The System information indicators show the current availability of hard disk space and
RAM on the currently selected Fiery ZX server. To retract the slider, click the icon at
the far right of the bar.
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Job ticket information

All the jobs listed by name in the Queues window can display the job ticket
information specified by the person who originated the print job. The Command
WorksStation can display this information because it parses the PostScript file before it
is RIPped.

You have considerable flexibility in arranging this information in the display. For
example, you can add Media Type to the display if you want to see which jobs call for
special paper or other media.

| Jab Tk | vase | Daamm | cepes | Sme |wetsTes |

You can choose not to display headers for options that are not used at your site, or you
can display all possible options and scroll to see the ones that are less important to you.
If you just want to experiment, when you are finished you can choose Revert to
Defaults from the File>Preferences menu.

To customize the display in the Queues window, you can:;

 Adjust the width of a column by clicking the column border in the heading and
dragging left or right.

< Choose the options you want to display, and the sequence in which you prefer to
view them. To add, move, or delete a column, hold down the right mouse button on
the appropriate job ticket item; release the button after choosing a menu option:

Add—one of the listed columns to the display at your mouse position
Move Left, Move Right—move the selected column left or right

Delete—the selected column

The Job Title and User are required; all other columns are optional.

Note: The Date/Time value indicates the date and time that the job arrived in the
Spool, RIP, or Print area.
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Spooling

RIPping

y

Printing

Window selection tabs

Lo

The Command WorkStation always starts out by displaying the Queues window, from
which you view current job processes and control job flow and file storage. To go to the
Job Log window, click the corresponding tab at the bottom of the Command
WorkStation display.

Queues window

The Queues window is a dynamic display of the job staging area: jobs are lined up for
processing and printing, some of them are being held waiting for directions, some are
moving from one stage or queue to another and are finally dropped from the list, some
are held for processing by the operator, and some are held in a different queue in case
you need to reprint them.

One approach to understanding the dynamic display is to imagine the three parts of
the Queues window corresponding to the three stages of printing, illustrated as a
downhill flow.

Spooling—a PostScript file is saved on the server’s hard disk. The file can come in
packets from the network, or from another place on the server hard disk. Jobs are
added to a queue in the order in which they arrive, and they generally move to another
queue in the same order unless an operator has intervened to change the order.

Rasterizing (RIPping)—PostScript commands are interpreted in the Fiery ZX to allow
the copier to print the file the way its originator intended. The result of this
interpretation is a raster file associated with the original PostScript file. In this raster file
(raster image), color data is associated with each dot that can be rendered by the print
engine. The color data tells the print engine whether or not to apply cyan, magenta,
yellow, or black toner to each position on the page.
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Printing—transferring the raster image from the server to the print engine at high
speed, freeing up RAM for the next job. While the PostScript file is usually saved to
disk, raster images are held in RAM during and after each print job. However, both
users and operators can request that the Fiery ZX save the raster image to disk along
with the PostScript file.

Saving the raster image to disk offers some advantages—raster files are already
processed so they print quickly, and each part of the raster file is still identified with a
page in the original document, which means that individual pages of a saved raster file
can be accessed.

Status bars

Jobs actively involved in the three processes (spooling, rasterizing, and printing) are
listed in the status bars that span the Queues window.

Status bars show the filename and user name for the active process, and an indication
of its progress. Each status bar heads the list of jobs that have completed the process.
Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP
status bar, you see a list of rasterized (RIPped) files; beneath the Print status bar, you
see a list of jobs that have already been printed.

Note: In the Spool status bar, the filename and user information always appear as
“Unknown” (as shown below). This information is not available until the job has
finished spooling to the Fiery ZX disk.

T Uinknawin

Spooled jobs on Hold (yellow)
Active spooled jobs (white)
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RIPped jobs on Hold (yellow)
Active RIPped jobs (white)
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Printed jobs (white); some include
raster files in RAM
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When a job is being processed, provided animation is enabled (see page 2-9), the
corresponding status bar is animated, indicating that the process is active.

If an error occurs, the corresponding status bar alerts you by displaying a message on a
red background instead of the normal blue background.

Enlarging the status bars Click the small arrows at the left of the status bar to
expand the status bar display. Click the arrows again to collapse the status bar to its
original size. To expand all the status bars at the same time, press Ctrl-E or choose
Expand/Collapse All from the File>Preferences menu. Click the arrows or press Ctrl-E
again to collapse them to their original size, or choose Expand/Collapse All again.
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Changing proportions By default, the status bars divide the window area into three
equal parts. You can drag the RIP and Print status bars up or down to change the
proportion of the window devoted to each job area. For example, drag the RIP status
bar down if you have a long list of spooled jobs that you want to see without scrolling.

Active jobs and held jobs

In the description that follows, assume that the operator has full control of jobs; that is,
the administrator has disabled the Direct connection and the Print queue, and all user
jobs come to the Hold queue. For more information about queues, see the
Configuration Guide.
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The operator’s job management functions permit holding a job at any stage of the

process we have described, as illustrated below. In the figure, boxes indicate types of job
icons you would see in the Queues window.

Spool

|\> Spooled and held

Spooled for printing

'

RIP

/

RIPped and held PostScript and

’/ raster data
Print*

RIPped for printing

'

Print

Print and hold

Printed ——p Deleted

*A copy of the held job is printed; the held job remains in the RIP area.

Jobs that are held are shown with a yellow icon in a yellow row, just beneath the Spool

or RIP status bar. Jobs that are held must be activated with a command in order to
print.

Active jobs are shown in white with white icons; new jobs are added above older jobs.
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Job icons

There are three types of icons that are used for both active jobs and jobs on hold.

Icon:

Active jobs:
(white icons and rows)

Jobs on Hold:
(yellow icons and rows)

PostScript icon

PostScript data after
printing, raster deleted

Job from network or job on Hold
after printing (Hold)

PostScript or raster data

PostScript data headed for Print

headed for printing and Hold
Printer icon
E PostScript and raster data PostScript data already rasterized
after printing, ready for fast and held
Raster icon reprint
Spool area

The job icons in the Spool area are described below:

Spool area icon:

What it indicates:

How long you see the job:

[EnY

Yellow PS icon
Yellow job row

PostScript data from a user on
the network; no destination is
defined

Until a destination is chosen

N

White printer icon
White job row

PostScript data headed for
Print

w

Yellow raster icon
White job row

PostScript data headed for
RIP and Hold

N

Yellow printer icon
White job row

PostScript data headed for
Print and Hold

Until the RIP is free
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The Spool area is both the receiving area for jobs from users on the network (Hold
queue) and the waiting area for jobs that will be RIPped (jobs in the Spool queue).

Hold queue jobs When printing requires an operator (because the Print queue and
Direct connection are disabled), the operator must assign a destination to all jobs
received from users on the network (icon 1 in the table above). Once assigned, jobs
(icons 2, 3, and 4) move down the Spool queue for processing. All jobs printed to the
Hold queue require routing by an operator.

Print queue jobs When printing does not require an operator, network jobs sent to
the Print queue appear in the Spool area where they are shown with a white printer
icon (icon 2). When they reach the head of the queue, they are RIPped and printed
without operator intervention.

Direct connection jobs Jobs printed to the Direct connection are not displayed in the
Command WorkStation job lists. They are displayed briefly in the status bars (where
they cannot be selected) and are included in the Job Log.

RIP area
The job icons in the RIP area are described below:

RIP area icon:

What it indicates:

How long you see the job:

O ER
Yellow raster icon
Yellow job row

Raster data, no destination
defined; may have been
printed before and held

Until it is deleted or stripped
of its raster data and sent to
the Spool area

8
White printer icon
White job row

Raster data headed for Print
in its turn; no hold defined

Until copier is free to print
the job

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data
(i.e., jobs that have been rasterized). Jobs in the RIP area are either waiting for the
copier to be free (Print queue jobs, icon 2 in the above table), or they are being held.
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Held jobs in the RIP area have already been rasterized (RIP and Hold) or they have
been printed and their raster data has been routed back to the RIP area (Print and
Hold), where they are shown in yellow rows (icon 1).

Note: Raster jobs in the RIP area that are waiting to print (icon 2 in the table above)
cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator deletes them. Printing these
jobs does not remove them from the RIP area. Instead, a copy of the job is created and
printed.

Note: For all rasterized jobs, the print option settings, in addition to the current
calibration state of the Fiery ZX, remain with the saved raster data each time the job is
reprinted. To print the job with new print option settings and with new calibration
data, you must remove the raster data and reRIP the job.

Print area
The job icons in the Print area are described below:

Print area icon: What it indicates: How long you see the job:
1 PostScript data only—raster Until the job limit is reached
data has been deleted

White PS icon
White job row

2 E Raster and PostScript data Until the job is reprinted or

If RAM is needed to RIP an the job limit is reached

White raster icon |, tjve job, the raster data is
White job row deleted and the job gets the

PSicon (icon 1, above)

The Print area, also referred to as the Printed queue, contains jobs that have already
been printed. These jobs were assigned the Print destination (white printer icon in the
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons
and rows.

NoTe: A job row that appears in light red indicates that a PostScript error occurred
while printing the job. To see the error, double-click anywhere in the row.
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Newly printed jobs are added to the Printed queue, and are shown at the top of the list.
Jobs are saved in the Printed queue until the job limit is reached. When the first job
over the limit is printed, the oldest job is deleted from the disk. The default job limit is
10 jobs. The value for Jobs Saved in Printed Queue can be changed in Setup by the
administrator.

Note: If you reprint a job in the Printed queue, the job returns to its original position
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript and raster data. The raster data in
RAM is not cleared until memory is needed to rasterize the next job. As long as the
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that
still have their raster data are represented by a white raster icon in the Printed queue
(icon 2 in the previous table); jobs with only PostScript data remaining are represented
by a white PS icon (icon 1). If the job was printed from a held raster job (in the RIP
area), the raster data in the RIP area remains and can be used to reprint the job after
the raster data has been cleared from the Printed queue.

Job commands

Job commands are used to assign a selected job to a new destination or process. These
commands are available from the Job menu (see page 2-9). Many are also available as
right mouse commands (described following the list of commands below). The job
commands available at a given time depend on the context; unavailable commands are
dimmed.

The job commands available for selected jobs in the Queues window are listed in the
following table. The table also describes the effect of each command on raster data
associated with the affected job(s).

Choose this: To do this: Raster data is:
Delete Delete the job(s) Deleted
Duplicate Duplicate one or more selected PostScript data n/a

jobs in the Spool or Print areas. You can use the
duplicate job(s) for different print options or a
different destination. (The Duplicate command
actually creates a reference to the original job,
with the same name)

(The Duplicate command is not available for
raster jobs)
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Choose this: To do this: Raster data is:

Rename Rename the job (PostScript file with or without Unaffected, but associated with the new name

raster) NoTEe: If the renamed job is printed, the Job Log
reflects the job’s original name.

Hold Hold the job in the current place (except forajob | Held in RIP area, if included with job
in the Print area, which is moved to the Spool or
RIP area, depending on whether it still has raster
data associated with it)

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does not | Temporarily held in RAM after printing until

have raster data)
After printing, keep the printed job in the Print
area until the job limit is reached.

memory is needed for another job

(If the job was printed from a held job in the RIP
area, the raster data in the RIP area is kept
indefinitely)

Print and Hold
(Like the user print
option Save Fast
Reprint)

Print the job in its turn (RIP it first if it does not
have raster data)

After printing, hold the PostScript data and the
raster in the RIP area

Held in RIP area indefinitely (saved to disk)

Process Next

Give top priority to this job

RIP (and then print) it as soon as the processor is
free, before other waiting jobs

Option is dimmed if there are no other waiting
jobs

n/a
NoTE: This command is available only for jobs in
the Spool area that are not currently held.

Remove Raster

Remove the raster data from a job that has raster
data (indicated by a raster icon); leave the
PostScript data unaffected

Deleted
NoTe: If you remove raster from a job in the RIP
area, the job is sent to the Spool area.

Properties View and override print settings for a selected job | Possibly deleted and regenerated, depending on
or a group of selected jobs whether you change any settings that require re-
RIPping
Thumbnail A Open the selected held raster data job in the Changed if job is edited, unaffected if job is only

Thumbnail A window where you can view a full-
screen preview of the job, edit the job, or merge it
with raster data from other jobs

viewed
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Choose this: To do this: Raster data is:

Thumbnail B Open the selected raster data job (not necessarily | Unchanged
a held job) in the Thumbnail B window for
viewing or for merging into a job in the
Thumbnail A window

Download Download files and fonts to the Fiery ZX with n/a
Fiery Downloader; see page 3-16

Using right mouse commands

Use the following instructions to activate job commands with a single right mouse
click.

TO ROUTE JOBS WITH RIGHT MOUSE COMMANDS:
1. To route a single job in the job list, right-click the job.

2. Select one of the commands or destinations and release the mouse button.

The command is carried out or the job is routed to the destination you chose.
Depending on your choice, the job line may reappear in a different part of the window
or a different window, or the job line may be deleted.

3. To route multiple jobs at the same time, select the jobs first.
Click the job line to select the first job. Shift-click to select adjacent jobs;
Ctrl-click to select nonadjacent jobs.

NoTe: Select jobs with the same job icon; otherwise, the destination options may not
be the same. For example, select multiple jobs in the Spool area, and choose Print.

4. With the cursor still in one of the selected job lines, press the right mouse button.

5. Select one of the commands or destinations and release the mouse button.

The command is carried out or the jobs are routed to the destination you chose.
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Job Log window

The Job Log is a list of processed and printed jobs, the date and time they were
processed or printed, and the characteristics of the job. It includes downloaded files
and fonts and RIP and Hold jobs.

Note: The Job Log window is not available if you logged in as Guest.

At any given time, the Job Log includes only those jobs processed or printed since the
Job Log was last cleared. The Job Log can be cleared manually from the Job Log
window or automatically if the administrator has enabled autoclearing of the Job Log
in Setup. The Job Log is also cleared whenever a Clear Server or Clear command is
executed (see page 1-7 and page 2-9).

You can adjust the column widths in the Job Log display by clicking the column
border in the heading and dragging left or right. For more information, see Chapter 3.
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When you open the Job Log, you can choose to display all jobs in the current Job Log
or only the jobs in a specified date range. By default, all jobs are displayed. To specify a
date range, select Range and enter dates in the From and To fields; or, click the
calendar icons next to the From and To fields and select dates by clicking them in the
calendars. Use the arrows at the upper corners of the calendars to display different
months. After you have specified the date range, click the Update icon to update the
Job Log display with your settings.

Note: In the Job Log, “Start Time” reflects the time that the job began RIPping; “End
Time” reflects the time that the job printed; and “Process Time” reflects the total RIP
time for the job. These times do not correspond to the Date/Time values displayed in
the Queues window.
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m Clear the Job Log

Export the Job Log

Print the Job Log

Updating the Job Log display To update the Job Log window display after specifying
a date range (or at any other time), click the Update icon.

Exporting the Job Log From the Job Log window, you can export the Job Log to a
tab-delimited text file. The exported file can be opened with a spreadsheet, database, or
word processing application. The exported Job Log contains the jobs for the date range
you specified.

Clearing the Job Log The Job Log is stored on the server disk. When logged in as
Administrator, you can clear the Job Log by clicking the trash icon. The Job Log is
cleared whenever an Administrator clears the server or installs new software. In
addition, the Job Log can be cleared automatically after every 55 jobs.

Printing the Job Log To print the Job Log, click the printer icon. The Job Log is sent
to the Hold queue and appears in the Spool area of the Queues window. You can use
Job menu commands to manipulate the Job Log print job as you would any other job.
Alternatively, you can choose Print Pages from the File menu, select Job Log, and click
Print. The printed Job Log contains the jobs for the date range you specified. See
“Using the Job Log” on page 3-21 for more information.
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Printing and clearing the Job Log automatically You can decide how you want to
handle the Job Log. If you have Administrator privileges, you can choose Setup from
the Server menu and enter your preferences in the Job Log Setup. You can choose to
print the Job Log automatically every 55 jobs, or both print and clear the Job Log
automatically every 55 jobs. You can also choose the Job Log page size.

Job properties

When logged in as Operator or Administrator at the Command WorksStation, you can
use the Properties command to check and override the print option settings
(properties) of all jobs.

You can use this command for several purposes:
 To override a setting based on printed output or other print device conditions
* To change settings for a duplicate of the original job

« To print a single copy of a job before printing the number of copies required by the
user

Viewing and editing job properties

The Properties command lets you view and edit the print option settings of multiple

jobs simultaneously. You can use this feature to compare the properties of several jobs
and thereby group together jobs with similar settings, if it is beneficial for throughput
or efficiency.

To view the properties of one or more jobs, select the job(s) and choose Properties from
the Job menu or the right mouse menu.
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For information on using the Properties dialog box to change job settings, see
“Viewing and overriding print settings” on page 3-14.

NoTe: Some print options that are available in the printer driver are not displayed in
the Properties dialog box. For information on specific print options and settings, and
where they can be set, see Appendix A of the Printing Guide.

Thumbnails and full-screen previews (DocBuilder)

The Command WorksStation includes a powerful DocBuilder tool that allows you to
preview and edit raster data. (For information on how to identify a raster data job, see
page 2-19.) DocBuilder consists of two thumbnail windows and several page-
manipulation commands (listed in the Page menu).

The DocBuilder tool can be used in the following ways:

« In the Thumbnail A window, you can see thumbnails of the currently RIPping job,
as it is processed, or of any raster data job (see “Previewing print jobs” on page 3-7).

e From the Thumbnail A window you can open a full-screen preview of a raster file
(see “Full-screen previews” on page 2-31).
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* Using the Thumbnail A and Thumbnail B windows together, you can merge raster
data from more than one file, even if the files were printed from different
applications on different computer platforms (see the next section and “Merging
raster files with DocBuilder” on page 3-9).

DocBuilder’s merge features eliminate the limitations of particular software

applications. You can merge raster pages of documents of different types, even different
computer operating systems. You can merge color pages from graphics programs with
text pages from a word processor. An outline of DocBuilder’s features follows; for more
information and applications, see “Merging raster files with DocBuilder” on page 3-9.

Editing and merging files with DocBuilder

When you select a raster data job and choose the Thumbnail A or Thumbnail B
command (from the Job menu or from the right mouse commands), the
corresponding Thumbnail slider opens automatically, displaying thumbnails of the
editable file. To close the Thumbnail slider, click anywhere in the tab along the right
edge of the Thumbnail window. When the Thumbnail window is open, the arrows in
the tab point to the right, indicating that clicking the tab retracts the slider.

With the Thumbnail A window you can see thumbnail views of any raster data job—
that is, any file that is currently RIPping, or any file that has been RIPped and held to
disk. You can also use the Thumbnail A window to edit a raster file—you can change
the sequence of pages, delete pages, duplicate pages, and copy pages from other raster
files into the Thumbnail A window. You can save the edited raster file as a new
printable document.

The Thumbnail B window can also display thumbnails of a raster job, and the
document displayed in Thumbnail B can be used as a source for editing the document
shown in Thumbnail A.

Note: Be careful not to delete all pages of a job in Thumbnail A without first saving a
copy of the job.
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Click here to close the Thumbnail A window
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You can merge documents by dragging (copying) one or more entire pages from
Thumbnail B to Thumbnail A. This creates a new document in the Thumbnail A
window. If you select one or more pages in the Thumbnail A window, the commands
in the Page menu give you additional editing possibilities. (Most of the Page menu
commands are also made available by right-clicking pages in Thumbnail A.) Multiple
undos of Page menu commands are possible.

You can merge pages from multiple documents into the Thumbnail A document by
opening documents one after another in the Thumbnail B window. Documents in the
Thumbnail B window are view-only, and while you can copy pages from Thumbnail B
to Thumbnail A, you cannot edit the Thumbnail B document. A merged document
that you create in Thumbnail A can be saved (with a different name) as a new raster
data file.

For more information, see “Merging raster files with DocBuilder” on page 3-9.
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Full-screen previews

Double-clicking any page in the Thumbnail A window opens a full-screen preview of
the page. The full-screen preview is a view-only display, and it takes time to retrieve the
data. Once begun, the process cannot be canceled.

Note: If you have edited a raster job with DocBuilder, you must save the edited file
before you can view full-screen previews of all its pages.

Using the icons in the full-screen preview, you can display adjacent pages, rotate the
page, or close the preview.

Click to view adjacent pages Click to
close the

full-screen

Click to rotate 90 degrees preview

clockwise







Chapter 3:
Managing
Print Jobs

3-1 | Communicating with users

This chapter provides some general information about managing printing with the
Fiery ZX Color Server and the copier, and gives you some hints on using the
Command WorkStation windows to monitor and manage print jobs. It suggests ways
to guide users so that their jobs are more likely to print correctly the first time. The
chapter also follows the course of a print job and shows possible ways to expedite jobs
and take advantage of the special capabilities provided by the Command WorkStation.

Communicating with users

The Command WorksStation interface facilitates communication between users and
operators. All the same, users who originate print jobs may need to become better
informed about the Fiery ZX and the copier so they can choose the appropriate
options for their jobs.

What the user needs to know

You or the network administrator should consider supplying some of the following
information to your users:

< The name of the printer on the network and the names of servers sharing the printer
» User’s access status

Do all jobs require operator intervention because they go to the Hold queue? If not,
which connections are published—Direct connection and/or Print queug?

« How long you will hold jobs on the server before you delete them
« List of default printer settings and other settings (from the Configuration page)
« List of installed fonts

Do the users’ applications download fonts automatically? If not, can users download
fonts, should they embed them in documents, or should they supply them to you so
you can download them?

» Requirements for Notes fields (information which appears in the Job Log)

For example, department name, account code, phone number or extension. Is some
information mandatory at your site?
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« Resident calibration target and date of current measurements
 Custom simulations

Are they available? What type of targets do they represent? Users see these print
options (CMYK Simulation) and should not select them if there are no custom
targets on the server.

« IP address or DNS name of printer so users can access Fiery WebTools, at least to see
if their jobs have printed

« Available media, alternative choices, standard tray/media configurations
« Information users might find in the WebLink web site
« Instructions for setting up the printer on client computers

« Sources of PostScript printer drivers, PPDs, color reference files, and additional
information

< Recommended PPD settings

« Conflicting settings and common PostScript errors

Customizing the Command WorkStation window

You can customize the display of job ticket information in the Queues window by
rearranging the headings. The Job Title and User name are always at the left, but you
can tighten the columns so you see what you need, and move and add other column
headings so the most important information is visible without scrolling. The following
procedure is also described on page 2-14.

TO CUSTOMIZE THE QUEUES WINDOW DISPLAY:

1. Right-click in the column heading.
A menu appears. The Add submenu lists the headings that are not already displayed.
2. Choose the options you want to display, and the sequence in which you prefer to view
them.

Add, delete, or move a column by holding down the right mouse button on the name
of the appropriate column heading; release the button after choosing one of the menu
options:

Add one of the listed columns to the display at your mouse position.
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Move Left, Move Right—move the selected column left or right.
Delete the selected column.
The Job Title and User columns are required—all others are optional.

3. Adjust the column widths.

Adjust the width of a column by clicking the column border in the heading and
dragging to the left or right. You can change the column widths at any time.

Printing server information pages

Using the Print Pages command from the File menu you can print various special
pages of information stored on the Fiery ZX. These include:

* Configuration—Prints the Configuration page, which gives the current server and
device configuration. This page lists general information about the hardware and
software configuration of the Fiery ZX, the current settings for all Setup options,
information about the current calibration, and the Ethernet and Token Ring
addresses of the Fiery ZX.

 Test Page—A Test Page enables you to confirm that the Fiery ZX is properly
connected to the copier, and provides color and grayscale samples to troubleshoot
problems with the copier or the Fiery ZX. The following settings are among those
listed on the Test Page: Server Name, Printer Model, color settings, calibration
information, date and time the Test Page was printed.

« Control Panel Map—Prints the Control Panel Map, which is an overview of the
screens you can access from the Control Panel. For information about using these
screens to set up the Fiery ZX, see the Configuration Guide.

* Font List—Prints a list of all fonts currently resident on the Fiery ZX hard disk.

« Color Chart—Prints samples of the RGB, CMY, and PANTONE colors available
from the Fiery ZX.

« Job Log—Prints a log of the last 55 jobs processed or printed. For information on
the fields in the Job Log and on printing it in other forms, see “Using the Job Log”
on page 3-21.

Server information pages printed with the Print Pages command appear in the
Fiery ZX Job Log with a User Name of “Operator” even if you logged in as
Administrator.



3-4 | Managing Print Jobs

Workflow scenarios

The workflow at your site will depend on the number and complexity of jobs and the
amount of responsibility given to the operator. This section suggests some ways you
might interact with a job.

Scenario 1 At this site, the Print queue is enabled, and anyone at the Command
WorkStation can view the progress of jobs. A small job is sent to a server and copier
that are not busy. You watch the job progress from the top to the bottom of the Queues
window.

The green light on the Fiery ZX flashes, the network icon blinks; on the Command
WorksStation the Spool status bar is animated and the job title appears. As soon as
spooling has finished, the Spool status bar is cleared and the RIP status bar animates.
Almost immediately thereafter, the RIP status bar is cleared and the Print status bar
animates. The printed job is listed below the Print status bar and the job pages emerge
from the copier. You move it to the mailbox of the person who sent the job.

Scenario 2 At this site, all jobs come to the Hold queue and therefore require
operator intervention to proceed.

Again, the green light on the Fiery ZX flashes, the network icon blinks, the Spool
status bar is animated, and now in the Spool area (below the status bar) the job title
comes into view. In a few moments the job is on the list, and you have time to scan the
headings for the job ticket information—media type, copies, and pages.

Are you ready for this job to print? Do other jobs have priority? What is the job for—
is it final output or a test print? The first choice is whether to put the job in the print
queue or hold it before processing it further. If you do nothing, the job remains in the
Spool area, and the file remains on the server disk.

Perhaps this is a routine job and does not call for special handling. You right-click the
job and choose Print. You notice the RIP status bar animate, and almost immediately,
the Print status bar animates. The printed job is listed below the Print status bar and
the job pages emerge from the copier.
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Scenario 3 Everyone has discovered the copier on the network and jobs are coming in
rapidly. You right-click several routine jobs in the Spool area and choose Print to let the
server print them one after the other. You choose Print and Hold if you know you will
be reprinting the job soon. You remove printed jobs from the output trays and
replenish media.

While some jobs are flowing through the queues and printing, you are preparing for
jobs that require more attention, such as obtaining special paper, using DocBuilder to
merge two documents, or notifying the originator of a job that a PostScript error
occurred.

Before you load special paper, you make sure all pending jobs are in holding areas.
When an especially important job is spooled for RIPping, you right-click Process Next.

Using the copier

If you have a copier job that has priority over the spooled incoming print jobs you can
temporarily close the Fiery ZX connection to the copier and then reopen it when you
have finished copying.

When there are no active printing jobs competing for the copier engine (no white job
lines in the Spool or RIP area), you do not need to suspend printing to make copies.

TO GIVE THE COPIER TOP PRIORITY AND LATER RESTORE PRINTER PRIORITY:

1.

From the Server menu, choose Suspend Printing.

This suspends printing temporarily. Jobs continue to spool and RIP on the server as
long as disk space and RAM are available.

When you have finished with the copier job, choose Resume Printing from the Server
menu.

The printing connection between the Fiery ZX and the copier is reopened and
printing resumes.
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Using the copier as a scanner

Scanning requires that you place the scan original on the copier, and that you run
Photoshop from a networked workstation. In a high-volume printing environment,
however, remote users who want to scan might have to wait for a connection to the
Fiery ZX.

Under those circumstances you or another operator may prefer to take over the
scanning function. ldeally, you would set up a networked workstation near the copier
and run Photoshop. From this workstation you can scan jobs for users in the slow
printing times.

Canceling jobs

You may need to cancel a job after it has been routed for processing or printing. You
can cancel a job only while it is being RIPped or while it is being printed. You cannot
cancel a waiting job (white job row) that is routed for RIPping or printing.

« Canceling jobs during processing—While a job is being RIPped, and its name
appears in the RIP status bar, choose the Cancel RIPping command from the Server
menu or right-click on the RIP status bar and choose Cancel RIPping.

When the RIP job is canceled, the Canceling message appears in the RIP status bar
and on the Fiery ZX Control Panel. The name of the canceled job appears in the Job
Log.

« Canceling jobs during printing—While a job is printing, and its name appears in
the Print status bar, choose the Cancel Printing command from the Server menu or
right-click on the Print status bar and choose Cancel Printing.

When the print job is canceled, Canceling appears in the Print status bar and on the
Fiery ZX Control Panel. The name of the canceled job appears in the Job Log.

Note: Canceled jobs may be partially printed, and may include pages with one or more
missing color planes, or pages that are completely blank.

« Canceling at the Control Panel—If you are at the Fiery ZX, the most direct way to
cancel a job is to press the top button on the server Control Panel while you can read
the name of the job that is processing or printing. For more information on the
Control Panel, see Chapter 1.
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Previewing print jobs

You can use the Thumbnail A window to preview pages of the currently RIPping job.
You can also use Thumbnail A, as well as Thumbnail B, to preview any raster data job
in the RIP or Print areas.

The thumbnail windows also allow you to open an editable thumbnail view of a held
raster job in the RIP area and perform electronic collation or document merging. This
feature, called DocBuilder, is described on page 3-9.

Previewing the currently rasterizing job

To see the progress of jobs as they are RIPped, you can leave the Thumbnail A window
open in RIP preview mode.

TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE:

1.

2.

Click the Thumbnail A tab at the right of the Queues window to open the slider.

Click the RIP preview icon at the left side of the window.

In this mode, Thumbnail A displays each page of the currently processing job after it
has been RIPped.
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3. Choose a PS file in the Spool or Print area and select RIP and Hold, Print, or
Print and Hold.

As pages are RIPped, they are displayed in the Thumbnail A window.

4. When you have finished viewing, click the Thumbnail A tab to close the thumbnail
window.

TO VIEW THUMBNAILS OF ANY RASTER DATA FILE:
1. Select any raster data job in the RIP or Print area.

2. Choose Thumbnail A or Thumbnail B from the Job menu.

If you choose Thumbnail A, make sure the raster data preview icon (at the left side of
the window) is selected.

Note: Wait until all pages have been displayed before opening another raster file with
Thumbnail A. If the job contains many pages, it may take some time for the entire job
to be displayed.
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3.  When you have finished viewing, click the Thumbnail A or Thumbnail B tab to close
the thumbnail window.
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Merging raster files with DocBuilder

The ability to work with raster files gives you new opportunities to combine
documents from different sources into a single raster file. For example, you can
combine full color covers and chapter head pages created in a page layout application
with two-color text pages created in a document processing application. Or, you can
customize a slide presentation by inserting slides from a different presentation.

You can display two raster files at once: a source file and a target file. The target file is
displayed in the Thumbnail A window, the source in Thumbnail B. Both files must be
held raster jobs in the RIP area.

NoTe: You cannot create a new PostScript file in this process; you must print the
merged raster file, which has references to the original PostScript files. Before editing or
merging files with DocBuilder, make sure the source files were RIPped using the print
option settings and the resident calibration you want for the final output. Raster files
edited with DocBuilder cannot be reRIPped.

TO VIEW AND EDIT RASTER DATA JOBS:

1. Select a raster data job and choose Thumbnail A from the Job menu.
The file must be a held raster job in the RIP area.

2. In the Thumbnail A window, right-click a thumbnail image to see the commands
available for pages in Thumbnail A.

These commands can also be accessed from the Page menu (see page 2-9) as well as
from buttons along the left side of the Thumbnail A window (see illustration below).
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To scroll through the pages in Thumbnail A, you can drag the slider bar at the bottom
of the screen, click in the empty area to the left or right of the slider bar, or click on the
arrows.

Click to open a full-screen
preview of the page

Click to duplicate a page

]
|

Click to delete a page
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Delete deletes the currently selected page.
Duplicate duplicates the currently selected page.

Open Preview opens a full-screen preview of the currently selected page (see “Full-
screen previews” on page 2-31).

Undo undoes the previous DocBuilder command—this command is available only from
the Page menu.

3. To move pages within Thumbnail A, left-click to select the page(s) and hold down the
mouse button as you drag the selected page(s) to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, non-
sequential pages. Make sure to release the Shift or Ctrl key before moving the pages.

If you move the page(s) on top of existing page(s), the page(s) will be overwritten.
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If the icon does not have an arrow, the page(s) will be replaced,; if the icon has an arrow,
the page(s) will be inserted.

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages
- -

Move single page Move multiple pages
before first page before first page

> R
Move single page Move multiple pages
after last page after last page

4. When you are finished editing, click the Thumbnail A tab.
If you have edited the job, you are prompted to save the job (click Yes) and enter a new
name.

5. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print. If you saved the edited file
with a new name, the original source file remains held in the RIP area.
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TO MERGE TWO RASTER DATA JOBS:

1.

In the Thumbnail A window, display the document you wish to edit.

The file must be a held raster job in the RIP area.

Right-click another source document file (a held job with a raster icon) and select
Thumbnail B.

The Thumbnail B tab opens a second thumbnail view which cannot be edited but can
be a source for pages added to the document in Thumbnail A.

Note: To merge documents, the page sizes of the source document and the target
document must be the same.

In the Thumbnail B window, left-click to select the page(s) and hold down the mouse
button as you drag the selected page(s) to the new location in Thumbnail A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, non-
sequential pages. Make sure to release the Shift or Ctrl key before moving the pages.

To scroll through the pages in Thumbnail A and Thumbnail B, you can drag the slider
bar at the bottom of the screen, click in the empty area to the left or right of the slider
bar, or click on the arrows.

To replace page(s), drag Thumbnail B page(s) on top of page(s) in Thumbnail A; to
add page(s), drag the page(s) to a new position between pages, before the first page, or
after the last page in Thumbnail A (see the icons on page 3-11).

Note: To insert a Thumbnail B page directly after the last Thumbnail A page, drag the
Thumbnail B page so that it is just to the right of the last Thumbnail A page and
shows an arrow pointing to the right. If the Thumbnail B page is placed too far to the
right of the last Thumbnail A page, the Thumbnail B page will replace the last
Thumbnail A page.



3-13 | Merging raster files with DocBuilder

E 1ok BRET |1 papssl]

Thumbnail B

ERErTTrEERn

FErcTrrrTer

| H
nl I o “1 Dl qued’ 1100 pagmis
E , h
5
ke
Page 4 copied from the EE
document in Thumbnail B LELLL 3
[ raSaN Y (] -
3
i™} 1.3
1] =] |

Multiple undos are available; use Ctrl-Z or the Undo command (from the Page menu)
to undo all the way back to your first edit. There is no Redo function.

Note: Make sure to save the merged job before deleting any of the jobs you used to
create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the
Thumbnail A job, such as the document and user name. However, many color-related
print options that are set in the Thumbnail B page, such as CMYK Simulation and
Rendering Style, remain with the specific page. This could result in a merged job being
made up of pages with different attributes.

Generally, the print option settings specified for the Thumbnail A job that are adopted
by the pages copied from Thumbnail B do not require reRIPping to take effect. The
one exception is the setting specified for the Save Fast Reprint option, which requires
reRIPping if you want to change it.
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The print option settings that remain with the pages copied from Thumbnail B into
Thumbnail A are generally those that do require reRIPing to take effect. The one
exception is the setting specified for the Paper Source option, which does not require
reRIPping if you want to change it.

Attributes that do not require reRIPping can be changed for the newly merged job
without having to reRIP any original PostScript files. Attributes that require reRIPping
result in reRIPping of the original PostScript file(s) associated with Thumbnail A.

4. To close the Thumbnail view, click once on the same tab you used to open it
(Thumbnail A or Thumbnail B tab).

5. If you have edited Thumbnail A, you are prompted to save the job (click Yes) and enter
a new name. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original
source and target files.

Note: If you print the edited raster file, it appears in the Job Log with the name of the
original job, not the new name you specified for the edited job.

Since you cannot create a new PostScript file by merging two raster data jobs, you must
print the merged raster file, which has references to the original PostScript files. If a
merged job is reRIPped and printed, then only the pages of the original PostScript job
in Thumbnail A will be processed and printed.

NoTe: In cases where multiple users are connected to the Fiery ZX via the Command
WorkStation, Fiery WebSpooler, and/or Fiery Spooler, and one user makes changes to
a Thumbnail A job, not all users may see the results of those changes. If you are unable
to view changes in a job, or if selecting a Thumbnail window results in a message
indicating zero pages, then close and relaunch the Command WorkStation, Fiery
WebSpooler, or Fiery Spooler.

Viewing and overriding print settings

When logged in as Operator or Administrator at the Command WorkStation, you can
view and override user job settings for any job in the Queues window. Using the
Properties dialog box, you can view and override job settings for a single job or for
multiple jobs at once. When viewing multiple jobs, you can override settings for each
job independently or override a setting for all the jobs at once.

Note: For PDF files, you are only able to override number of copies and page range
from the Properties dialog box.
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« To view the properties for a single job, double-click the job line or select the job and
choose Properties from the Job menu or right mouse menu.

« To view the properties for multiple jobs at once, shift-click to select contiguous jobs,
or Ctrl-click to select non-contiguous jobs, and choose Properties from the Job
menu or right mouse menu.

Note: If you want to retain a copy of the job with its original settings, duplicate the job
and rename the duplicate before you change any settings (see “Job commands” on
page 2-22).

To override a setting for a single job, right click on the current setting and choose the
override setting from the pop-up list.

NoTe: For some options, changing the setting requires that the job be reRIPped; these
options show an icon to the left of the option name.
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To override settings for all jobs listed in the Properties dialog box, right click on the
name of the print option (the row header) at the left of the dialog box and choose the
override setting from the pop-up list.
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Note: The Properties dialog box displays all the job settings encoded by the PostScript
printer driver that can be decoded by the Fiery ZX. If you (as operator) have not
changed anything, these are the settings a user entered before sending the job. Some
print options that are available in the printer driver are not displayed in the Properties
dialog box. For information on specific print options and settings, and where they can
be set, see Appendix A of the Printing Guide.

Downloading files and fonts

From the Command WorkStation you can download a variety of file types, as well as
fonts, to the Fiery ZX. These files and fonts can be located anywhere on the network or
on an external device connected to the Command WorkStation computer. You browse
to locate the files and fonts, select them, and add them to a list of items to be
downloaded. You can specify a limited number of print option settings for files that
you download (see page 3-19).
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To download fonts, the Direct connection must be used. If the Direct connection is
not currently published in Setup, see the Configuration Guide for instructions on how
to publish it.

Note: You cannot download TrueType fonts. If you use TrueType fonts in Windows,
you can print them by converting them to Adobe Type 1 fonts. To do this with the
Adobe PS printer driver, click the Fonts tab and set up the Font Substitution Table as
necessary.

The Manage Fonts command provides another way to download fonts to the Fiery ZX
(see page 3-20).

TO DOWNLOAD FILES OR FONTS:

1. Choose Download from the Job menu, or right click on the Spool status bar and select
Download.

The main Fiery Downloader window appears.
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2. Choose the file types to display in the Files of type menu.
You can leave this at the default All Known Formats or choose All Files. All Known
Formats lists all files in supported formats; All Files lists all files.

3. Choose the Queue to which you will download the files.

The options available in this menu depend on the print connections currently enabled
in Setup. The potential choices are Print Queue, Hold Queue, or Direct Connection. If
your administrator has not enabled one or more of these connections, you cannot
choose it.

To download fonts, you must choose Direct Connection.
PDF files are always spooled to the Fiery ZX hard disk before being printed. PDF files
must be sent to the Print queue (or to the Hold queue if the Print queue is not
enabled). Do not choose Direct Connection to download PDF files.

4. Select the filename and click Add.
The File name field displays the name of the selected file before you click Add.

You can navigate to different drives and directories to select files and fonts to
download.

To select multiple sequential files, select the first file and then Shift-click the last file.
Ctrl-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to be Downloaded
list and click Remove.
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5. To change the attributes of a file to be downloaded, select it and click Options.

The Options dialog box for PostScript and EPS files is different from that for PDF
files, as explained below.
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6. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or
leave the default settings, for each file.

Copies—Specify the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file
appears to be too dark or too light. Choose 85% for a substantially lighter image, 115%
for a substantially darker image, or one of the options in between.

Note: Some applications, including Adobe Photoshop, provide transfer functions that
let you specify density settings for an image. If the file you are printing includes
transfer functions, the Brightness option has no effect. For more information on using
transfer functions, see the documentation for your application.

‘showpage’ (after EPS files)—In most cases, you do not need to use this option. Select
the ‘showpage’ (after EPS files) option only if an EPS file fails to print without it. This
option adds a ‘showpage’ PostScript language command at the end of the print job.
Some applications omit this necessary PostScript language command when they
generate EPS files. Select this option when printing EPS files generated by these
applications. If you select this option unnecessarily, extra blank pages may print.

If you experience problems downloading EPS files, you can print the file directly from
the application in which you created it.

Page Range (PDF files only)—Specify the page range you want to print.
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7. Click Download.

To cancel downloading, click Cancel.

Managing server fonts

The Fiery ZX includes a number of built-in printer fonts. You can download
additional fonts to the Fiery ZX using the Manage Fonts command (see below) or the
Download command (see page 3-16). Users on the network can also download fonts
to the server using the Fiery Downloader (see the Printing Guide). Downloading fonts,
either from the Command WorkStation or with the Fiery Downloader, requires that
the Direct connection is published in Setup (see the Configuration Guidg).

Note: The Manage Fonts command is available only if you logged in as Administrator.
Although no special privileges are necessary to download fonts, Administrator

privileges are required to remove fonts from the server. The built-in printer fonts are
locked and cannot be removed by anyone.

To print a list of fonts currently resident on the Fiery ZX, use the Print Pages
command (see page 3-3).

TO ADD OR DELETE FONTS:

1. Choose Manage Fonts from the Server menu.

Locked fonts

Downloaded fonts
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2.

The Server Fonts window displays Add, Delete, and Update buttons.

To download additional fonts to the Fiery ZX, click Add and refer to the instructions
on page 3-16.

To delete a font, select it in the font list and click Delete. Shift-click or Ctrl-click to
select multiple fonts.

Note: The printer fonts included with the Fiery ZX (built-in fonts) are locked. These
fonts appear with a lock icon next to the name and cannot be deleted.

To refresh the font list display, click Update.

Using the Job Log

Chapter 2 introduced the Job Log, which is the list of all processed and printed jobs,
including the date and time they were printed, and all the characteristics of the job. It
explained that the Administrator can set Job Log preferences for clearing and printing
the Job Log automatically, and for Job Log page size (page 2-25).

After displaying the Job Log you can print it (using either the Print icon or the Print
Pages command), or export it to a tab-delimited file. The exported Job Log file can be
imported into a spreadsheet, database, or word processing application for job
accounting purposes. If only a portion of the Job Log is displayed (such as jobs for the
current day), only that portion of the Job Log is printed or exported.

Note: When you print the Job Log, the print job is sent to the Hold queue and
appears in the Spool area of the Queues window with the job title “Job Log” and the
user name “Operator” (even if you logged in as Administrator). You can then use Job
menu commands to manipulate the Job Log print job as you would any other job.

After printing or exporting the entire Job Log, you may want to clear it; you clear the
Job Log by clicking the Delete (trash can) icon.
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Icons appear above the Job Log. The icons are:
Update Click to update the information in the Job Log window.

Print Click to print the currently displayed portion of the
Job Log to the Hold queue. You can use Job menu
commands to manipulate the Job Log print job as you
would any other job.

Export Click to export the currently displayed portion of the
Job Log to a tab-delimited file.

Delete Click to delete the Job Log (you will be asked for
confirmation).
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Calendar Click to display a calendar and specify a date range.
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The Job Log window displays a list of all the jobs and the following information about
them: status, document name, user, date, start time, end time, process time, size,
device, page size, media, number of originals, number of color pages, number of black
and white pages, and total number of pages.

Note: If a raster job was saved in DocBuilder with a new name and then printed, it
appears in the Job Log with the name of the original job, not the new name you
specified for the edited job.
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The text in the Status column provides information about the job:

OK The job was printed normally.
Cancel The job was canceled before printing was completed.
Error An error occurred during processing or printing.

The information in the Notes 1 and Notes 2 fields is displayed if users entered this
information when they printed.

Note: The Notes fields are supported only for jobs printed with the Adobe PostScript
printer drivers provided on the User Software CD. They are not supported for jobs
printed from Windows NT 4.0.

Use the scroll bar at the bottom of the window to view all the fields in the Job Log
window.

Server management commands

The following Server menu commands are used to manage server performance,
configuration, and status. Some of these commands are available only when logged in
as Administrator.

« Calibrate—Opens the Fiery Print Calibrator (see Chapter 6 and Chapter 7)

« Reboot—Causes the Fiery ZX to be rebooted, just as if you had selected Reboot
Server from the Control Panel (see page 1-5)

« Clear—Clears all jobs in all server queues as well as the Job Log.
« Setup—Invokes Fiery Setup (see the Configuration Guide)

e Manage Fonts—Allows you to delete fonts from, as well as add fonts to, the Fiery ZX
(see page 3-20)
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This chapter introduces Fiery WebTools and provides instructions on their usage. For
more information on certain Fiery WebTools you are referred to other chapters in this
book and to other manuals in the documentation set.

Fiery WebTools

Fiery WebTools reside on the Fiery ZX but can be accessed over the network from a
variety of platforms. The Fiery ZX has a home page that lets remote users view server
functions and manipulate jobs.

Fiery WebTools can be used on Windows 95, Windows NT 4.0, and Mac OS client
computers with certain Internet browsers that support the Java language. For specific
information on the browsers supported with Fiery WebTools, see Getting Started.

Access privileges

The Fiery ZX system allows the site administrator to choose and implement a level of
access and control appropriate for your particular site. There is a spectrum of control
which can be implemented; the levels of access allowed to remote users depend on
whether the administrator has enabled use of the Fiery WebTools, and whether or not
a password is required to use the job management features of the Fiery WebTools.

If you have been given the Operator password, you can manage job flow and override
print settings of your jobs with the Fiery WebSpooler. If not, you can still track the
status of your jobs with the Status tool, and with the Fiery WebSpooler as a Guest.
Check with your site administrator for information on your Fiery WebTools access
privileges.
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Using Fiery WebTools

Fiery WebTools are accessed from the Fiery ZX home page.

WebTool: Summary: For more information:

Status Shows you the jobs currently processing | See the Printing Guide
and printing.

WebSpooler Allows you to view, manipulate, reorder, | See “Tracking and managing
reprint, and delete jobs currently jobs with the
spooling, processing, or printing on the | Fiery WebSpooler” on page 5-1
Fiery ZX. It also allows you to view,
print, and delete the Job Log.

WebLink Provides a link to another web page, See the Printing Guide and the
provided you have a valid Internet Configuration Guide
connection. The WebLink destination
can be changed; this function requires
the Administrator password, if one has
been set.

Installer Allows you to download Fiery ZX See Getting Started
printer file installers directly from the
server.
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To ACCESS FIERY WEBTOOLS:
1. Start up your Internet browser application.

2. Enter the IP address or the DNS name of the Fiery ZX.
Check with the operator or administrator for this information.
The Fiery ZX home page appears.
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3. Click one of the buttons at the left to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.






5-1 | Tracking and managing jobs with the Fiery WebSpooler

Chapter 5:
Fiery WebSpooler
and Fiery Spooler

The Fiery WebSpooler and the Fiery Spooler for Windows are job management tools
that duplicate many of the functions and features of the Command WorkStation.

« The Fiery WebSpooler, one of the Fiery WebTools, is accessed with an Internet
browser and the Fiery ZX home page (see Chapter 4).

 The Fiery Spooler is installed from the User Software CD. To use the Fiery Spooler,
users need only a network connection to the Fiery ZX. For Windows computers, the
Fiery Spooler requires a TCP/IP network connection.

The interface of the Fiery Spooler for Windows computers is virtually identical to that
of the Fiery WebSpooler. Moreover, the interfaces of these tools are so similar to that of
the Command WorksStation that this chapter often refers you to Chapters 2 and 3 (on
the Command WorkStation) for information about icons and commands that is
common to all three tools.

The interface of the Fiery Spooler for Mac OS computers is significantly different from
that of the other utilities. It is described in detail at the end of this chapter.

Tracking and managing jobs with the Fiery WebSpooler

You can use the Fiery WebSpooler (and the Fiery Spooler for Windows) to perform the
following functions from your workstation:

« Override current job option settings

* Delete jobs and cancel processing

« Duplicate or rename jobs

« RIP ajob and hold the raster data

« Hold jobs in the spooled area or the RIPped area
» Remove raster data from RIPped files

» Change the priority of jobs

« Edit and merge raster data jobs (DocBuilder)

« Display, print, or delete the Job Log
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Most of these functions require the Administrator or Operator password. However,
even without a password, you can log in to the Fiery WebSpooler as Guest with view-
only privileges.

NoTe: Most Fiery WebSpooler commands function identically to those of the
Command WorkStation. For more information on specific commands, see Chapters 2
and 3.

To ACCESS THE FIERY WEBSPOOLER WINDOW:

1.

From the Fiery ZX home page window, click WebSpooler.
For instructions on how to access the Fiery ZX home page window, see page 4-3.
To log in as Administrator, enter the Administrator password and click OK.

To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering any password.

The Fiery WebSpooler window appears in a new browser window.

METI e
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About the Fiery WebSpooler window

Like the Command WorksStation, the Fiery WebSpooler is a window to view Fiery ZX
and copier functions, and an interface from which you can control those functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print
status bars. When the Fiery ZX receives print jobs, the Fiery WebSpooler window
becomes a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages
of printing a job. Jobs come in at the top level (Spool) and drop down to the Print
level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained in “Job icons”
on page 2-19.

Note: In Fiery WebSpooler and Fiery Spooler, the “PS” characters do not appear inside
yellow PS icons (in the Spool area) and white PS icons (in the Print area).

Spooled jobs—1Jobs listed in the area below the Spool status bar are PostScript files
stored on the Fiery ZX disk. These jobs were sent to either the Print queue (white
icons) or the Hold queue (yellow icons).

RIPped jobs—1Jobs listed in the area below the RIP status bar are ready to print. They
have already been rasterized (RIPped, or processed for printing) and are waiting, in
order, for access to the printer. Rasterized jobs can also be held; held jobs are shown
with a yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been
printed. Printed jobs can be stored on the Fiery ZX disk. The number of jobs that can
be stored (from 1 to 99) is defined in Setup.
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If you are logged in as Administrator or Operator, you can interact with a job wherever
it appears in the window by selecting it and choosing a command from the Job menu,
or by double-clicking the job and setting override options. See “Manipulating job
options and job flow” on page 5-4 for information.

Errors—Jobs with an error are shown in red. To display the error, double-click the job
line.

Norte: If your job does not appear anywhere in the Fiery WebSpooler window, it may
have already been printed; if so, it will appear in the Job Log. To view the Job Log,
choose Show Job Log from the Window menu. (For more information on the Job Log,
see page 5-8.)

Manipulating job options and job flow

Using the commands in the Job menu, you can alter the destinations, priorities and
other characteristics of jobs that appear in the Fiery WebSpooler window.
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To understand the effect each of these commands has on a job, you need to understand
the way the Fiery ZX handles PostScript and raster data, and how jobs are activated or
held in the various stages of processing. See Chapter 2 for this background information
before manipulating jobs with the Fiery WebSpooler. Also, the commands in the
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Fiery WebSpooler Job menu have identical counterparts on the Command
WorkStation. For background and information about these commands, see Chapters 2

and 3.

Choose this command

from the Job menu: To do this: Raster data is:
Delete Job(s) Delete the job(s) from the list Deleted
Duplicate Job(s) Duplicate one or more selected PostScript data | n/a

jobs in the Spool or Print areas (creates a
reference to the original job, with the same
name)

(The Duplicate command is not available for
raster jobs)

Rename Rename the job (PostScript file with or without | Unaffected, but associated with the new name

raster) NOTE: If the renamed job is printed, the Job
Log reflects the job’s original name.

Hold Hold the job in the current place (except fora | Held in RIP area indefinitely, if included with
printed job, which is moved to the Spool or job
RIP area)

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does Temporarily held in RAM until memory is

not have raster data). Keep the printed job in
the Print area until the job limit is reached

needed for another job

Print and Hold
(like the PPD option
Save Fast Reprint)

Print the job in its turn (RIP it first if it does
not have raster data)

After printing, hold the PostScript data and the
raster in the RIP area

Held in the RIP area indefinitely (saved to
disk)

Process Next

Give top priority to this job

Print the job (or RIP and print) as soon as the
processor and copier are free, before other
waiting jobs

Held in RAM after printing (can be selected in
the Print area while it remains there), or Held
in RIP area (saved to disk) if destination was
RIP and Hold

Remove Raster

Remove the raster from a job that has raster
data; leave the PostScript job in place

Deleted

Override Print Settings

Change the print options for the job
(see page 5-6)

Deleted and regenerated, if the newly selected
options require reRIPping, or reprinted with
the new settings, if none require reRIPping
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Choose this command

necessarily a held job) in the Thumbnail B
window for viewing or for merging into a job
in the Thumbnail A window

from the Job menu: To do this: Raster data is:
Thumbnail A Open the selected held raster data job in the May be changed if job is edited
Thumbnail A window where you can view a
full-screen preview of the job, edit the job, or
merge it with raster data from other jobs
Thumbnail B Open the selected raster data job (not

Unchanged

Overriding job option settings

To change the job options of a job, double-click the job line or select the job and
choose Override Print Settings from the Job menu. If necessary, scroll down to see all

the various job options.

Indicates reRIPping is required
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The options you set here are the same ones you set from the Print dialog box when you
print from an application. For information about setting and overriding these print
options, see the Printing Guide.

Note: For some options, changing the setting requires that the job be reRIPped; these
options show an icon to the left of the option name.

Thumbnails and full-screen previews (DocBuilder)

Like the Command WorkStation, the Fiery WebSpooler includes a powerful
DocBuilder tool that allows you to preview and edit raster data. DocBuilder consists of
two thumbnail windows and several page-manipulation commands (listed in the Page
menu). The DocBuilder tool can be used in the following ways:

« In the Thumbnail A window, you can see thumbnails of the currently printing job,
as it is processed, or of any raster data job.

e From the Thumbnail A window you can open a full-screen preview of a raster file.

 Using the Thumbnail A and Thumbnail B windows together, you can merge raster
data from more than one file, even if the files were printed from different
applications on different computer platforms.

DocBuilder’s merge features eliminate the limitations of particular software
applications. You can merge raster pages of documents of different types, and even
different computer operating systems. You can merge color pages from graphics
programs with text pages from a word processor.

Note: In cases where multiple users are connected to the Fiery ZX via

Fiery WebSpooler, Fiery Spooler, and/or the Command WorkStation, and one user
makes changes to a Thumbnail A job, not all users may see the results of those changes.
If you are unable to view changes in a job, or if selecting a Thumbnail window results
in a message indicating zero pages, then close and relaunch Fiery WebSpooler, Fiery
Spooler, or the Command WorkStation.
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DocBuilder differences in Fiery WebSpooler

The DocBuilder tool in Fiery WebSpooler functions almost identically to that in the
Command WorkStation. For detailed information on using DocBuilder, see Chapters
2 and 3 (for instructions on editing and merging raster files, see “Merging raster files
with DocBuilder” on page 3-9). Though the interfaces are almost identical, there are
some feature differences:

« You cannot scroll through the pages in Thumbnail A or Thumbnail B by dragging
the slider bar at the bottom of the screen.

e Thumbnail A right-click commands are not available; instead click on a page to
select it, and either click the appropriate button in the Thumbnail A window or
choose the appropriate command from the Page menu.

* Page icons and arrows do not appear when moving page(s) from Thumbnail B to
Thumbnail A. Instead, a blue outline appears around a Thumbnail A page that is to
be replaced; and a blue bar appears adjacent to or between Thumbnail A page(s) to
indicate where the Thumbnail B page(s) are to be inserted.

 The full-screen preview window has a status bar (the Command WorkStation does
not), the “X” button used to close the full-screen preview is in a different location,
there are no page advance arrows, and there is no rotate button.

« The Ctrl-Z keyboard shortcut for the Undo command is not available. To undo one
or more DocBuilder commands, choose Undo from the Page menu.

Using the Job Log

From the Fiery WebSpooler, you can view and print a log of all jobs printed by the
Fiery ZX, including jobs downloaded with the Fiery Downloader.

Note: If you logged in as Administrator, you can delete the Job Log from the
Fiery WebSpooler (see page 5-10). The Job Log is not available if you logged in as
Guest.
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TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.
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3. Click OK.

The Job Log appears in a new browser window.

Note: The Delete button appears only if you logged in as Administrator.
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The Job Log displays each job and the following information: status, document name,
user name, date, start time, end time, process time, file size, device, paper size, media,
number of originals, number of color pages, number of black-and-white pages, total
number of pages, Notel, and Note2.

The Status column provides the following information about jobs:
OK The job was printed normally.

ERROR An error occurred during processing or printing.
CANCEL The job was canceled before printing was completed.

4. To update the Job Log, click the Update button.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print
button.

The information displayed in the Job Log window prints to the current Fiery ZX.
When you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File menu
or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

Fiery Spooler for Windows computers

For Windows 95 and Windows NT 4.0, the Fiery Spooler interface is almost identical
to that of the Fiery WebSpooler (see “Differences between Fiery Spooler for Windows
and Fiery WebSpooler” on page 5-12), and both interfaces are very similar to the job
management interface of the Command WorksStation. For details on the icons and
commands in the Fiery Spooler (and Fiery WebSpooler) see Chapters 2 and 3.

Note: A TCP/IP network connection is necessary to use Fiery Spooler on a Windows
computer. For more information, see Getting Started.



5-11 | Fiery Spooler for Windows computers

TO LAUNCH FIERY SPOOLER ON A WINDOWS COMPUTER:
1. Choose Fiery Spooler from the Start > Programs menu.

2. Select the Fiery ZX in the Chooser window that appears.
For information on setting up the connection to the server, see Getting Started.

3. Click OK.
The Fiery Spooler main window appears.

(R 1 LB ]

For information on using Fiery Spooler for Windows computers, see “Tracking and
managing jobs with the Fiery WebSpooler” on page 5-1 and Chapters 2 and 3.
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Differences between Fiery Spooler for Windows and
Fiery WebSpooler

Though the interfaces for both Fiery Spooler for Windows and Fiery WebSpooler are
almost identical, there are some feature differences.

Connecting to a different Fiery ZX

With the Fiery Spooler, you can connect to a different Fiery ZX from within the
application using the following procedure.

TO CONNECT TO A DIFFERENT FIERY ZX:
1. Choose Open Fiery from the File menu.

2. Select the Fiery ZX in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.

3. Click OK.
The Fiery Spooler main window appears.

Saving the Job Log as a file

With Fiery Spooler, you can save the Job Log as a file that you can view with a different
application.

To SAVE THE JOB LOG AS A FILE:

1. Choose Export Job Log from the File menu or click the Export button at the top of the
Job Log window.

Export button

2. In the File name area, enter a name for the Job Log file (the default name is
Fiery Job Log.txt).

3. Browse to the location where you want to save the file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.
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You can view the information in any application that can read a text file. Items are
separated by tabs.

Fiery Spooler for Mac OS computers

For Mac OS computers, the Fiery Spooler interface and functionality differs from the
Command WorkStation, the Fiery WebSpooler, and the Windows version of
Fiery Spooler.

On a Mac OS computer, Fiery Spooler jobs can be in one of the following queues:

Print Normal print jobs sent to the Fiery ZX appear in the Print queue. You
can move and manipulate these jobs as described below.

Hold Jobs sent to the Hold queue remain in the queue until they are moved to
the Print queue or deleted. If you need to print the same document
frequently, you can send it to the Hold queue and move a copy of the
job to the Print queue every time you need to print it. You can also send
large jobs to the Hold queue and then move them to the Print queue
when other users are not printing.

Printed The jobs most recently sent to the Fiery ZX are saved in the Printed
queue. You can drag these jobs back to the Print queue to print
additional copies. The number of jobs saved in the Printed queue is set
by your system administrator in Fiery ZX Setup.

Jobs in the queues are stored on the Fiery ZX hard disk. Make sure that you leave
enough space on the hard disk for fonts and other Fiery Spooler jobs.

You can use the Fiery Spooler Job Log to view information about jobs printed to the
Fiery ZX for job accounting purposes, or saved for reference. The Job Log can be
printed to the Fiery ZX or saved as a file and viewed in other applications.

TO LAUNCH FIERY SPOOLER ON A MAC OS COMPUTER:
1. Double-click the Fiery Spooler icon.

2. If your network is divided into zones, select the zone in which the Fiery ZX is located.
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3. Select the Fiery ZX from the list of servers th
The Fiery Spooler main window appears.
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To access Administrator functions, choose Password from the Administrator menu.

This menu is active only if a password was created on the Fiery ZX.

Enter the password in the window that appears, and click OK.
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The job list includes information about the document name, user name, time and date

sent, print device, and file size.
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The window is split into regions that correspond to the different queues and steps in
the printing process. You can click and drag a job to the Print or Hold region of the
window to move it to the corresponding queue.

Buttons appear above the scroll list. The buttons are:

Update

Duplicate
and Print

Print

Hold

Delete/
Cancel

Click this button to update the information in the Fiery Spooler main
window.

Drag a document onto this button or select the document and click
this button to duplicate it and put the duplicate in the Print queue.

Drag a document onto this button or select the document and click
this button to print it to the Print queue.

Drag a document onto this button or select the document and click
this button to move it to the Hold queue.

Drag a document onto this button or select the document and click
this button to delete it or cancel processing or printing it. You will be
asked to verify that you want to delete the job. You can eliminate the
verification notice by turning off the Confirm file deletion option in
the Preferences dialog box.

The icons provide information about the job:

Printing icon

Printing icon

RIP icon

Print icon

The job that is currently printing appears in this list; it can be selected
and deleted to cancel printing.

Jobs that have been processed and are waiting to print appear in this
list, but they are dimmed because their settings cannot be changed
and they cannot be moved or canceled.

Jobs that are processing appear in this list; they can be selected and
deleted to cancel processing.

Jobs that have not been processed appear in this list, in the order they
will be processed and printed. The jobs can be selected and deleted to
cancel processing and printing.
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Hold icon Jobs in the Hold queue appear with the Hold icon. You can move the
job to the Print queue to print it.

RIP and Jobs that have been RIPped and held appear in the Hold queue with
Hold icon the RIP and Hold icon. You can move the job to the Print queue to
print it.

Printed icon  Jobs that have been printed are saved in this list. Jobs are stored in the
Printed queue until the limit set by your system administrator in
Fiery ZX Setup is reached. The jobs can be selected and deleted from
the Fiery ZX hard disk.

Alert icon If a PostScript error occurred while a job was printing, it appears in
the Printed queue with an Alert icon (the Printed icon with a red
slash) next to it. You can double-click the Alert icon to display the
error message. The jobs can be selected and deleted from the Fiery ZX
hard disk.

Choose Preferences from the Edit menu to configure how the Fiery ZX updates and
deletes files.
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You can use this window to specify that the Fiery ZX:

Update Automatically every n seconds or Update Manually—This option lets you
specify whether the Fiery Spooler main window is automatically updated every 20
seconds (or at an interval that you set), or whether it is updated only when you choose
the Update command from the Window menu. By default, the Fiery Spooler main
window is updated automatically every 20 seconds.

Note: When automatic updating is on, data is coming from the Fiery ZX across the
network very frequently. This data adds to the network traffic, and may slow down
other network jobs. For optimum network performance, turn off automatic updating
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in the Fiery Spooler Preferences dialog box; when you want to view updated
information in the Fiery Spooler window, choose Update from the Window menu or
click the Update button.

Confirm file deletion—Select this if you want a confirmation dialog box to appear
before you delete a file.

Duplicating, copying, moving, and deleting jobs

Users monitor their own print jobs. The Fiery ZX system administrator (or anyone
with Fiery Spooler Password access) can move, delete, and configure jobs for all users,
and can re-order jobs within a queue.

You can move your jobs from the Hold queue and the Printed queue to the Print
queue. If, for example, you frequently print the same file, you can send it to the Hold
queue and later drag a copy of the file to the Print queue. By copying rather than
moving a job, you leave a copy of the job in the Printed queue so that you can print the
job again later. You can also duplicate a job if you want to have multiple copies of a job
in the same queue.

Duplicating jobs
You can duplicate jobs in the Print and Printed, and Hold queues:

« If you want to change printing parameters in the Override Print Settings dialog box
without losing the original settings

« If you want to print more than 15 copies to the sorter (the maximum number of
copies that you can print to the sorter is 15)

When you duplicate a job, the Fiery ZX creates a reference to the original file, so
duplicate files do not require the full amount of disk space on the Fiery ZX. As long as
one of the duplicates remain, the Fiery ZX saves the file, so you can delete all but one
reference to a file.
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TO DUPLICATE A JOB WITHIN A QUEUE:

1.

Select the job that you want to copy by clicking its name.

The selected job is highlighted. If you want to select more than one job, shift-click to
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent
jobs.

Choose Duplicate Job(s) from the Edit menu.

The job appears at the bottom of the queue.

TO DUPLICATE AND PRINT A JOB:

1.

Select the job that you want to copy by clicking its name.

The selected job is highlighted.If you want to select more than one job, shift-click to
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent
jobs.

Click the Duplicate and Print button, or drag the job to the Duplicate and Print button.
The job appears at the bottom of the Print queue.

TO COPY A JOB TO ANOTHER QUEUE:

1.

Select the job that you want to copy by clicking its name.

The selected job is highlighted. If you want to select more than one job, shift-click to
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent
jobs.

Hold down the Option key as you drag the job to either the Hold or Print queue icon or
to the Hold or Print section of the job list.

A copy of the job is moved to the queue you have selected, but the original job still
appears in the Hold or Printed queue so that you can print the job at another time.
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TO MOVE A JOB WITHIN A QUEUE:

1.

2.

Select the job that you want to move by clicking its name.

The selected job is highlighted. If you want to select more than one job, shift-click to
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent
jobs.

Drag the file to the new location in the queue.

TO MOVE JOBS BETWEEN QUEUES:

1.

Select the job that you want to move by clicking its name.

The selected job is highlighted.If you want to select more than one job, shift-click to
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent
jobs.

Move the selected job to another queue by dragging it to the queue icon of your
choice or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print queue by
dragging the job to the Print queue icon.

TO DELETE A JOB FROM ANY OF THE QUEUES:

1.

2.

Select the job that you want to delete by clicking its name.

Drag the selected job to the Delete button or click the Delete button.
You can also choose Delete Job(s) from the Edit menu.

System administrators (or anyone with Fiery Spooler Password access) can delete any
job.

Changing print settings for a job

You can set certain printing parameters for a job in the Override Print Settings dialog
box. The settings in this dialog box override the settings in the Printer Specific Options
dialog box and in Fiery ZX Setup.
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You can change printing parameters only for jobs in the Hold, Print and Printed
queues of the Fiery Spooler main window.

System administrators (or anyone with Fiery Spooler Password access) can change print
settings for any job.

Note: The Override Print Settings dialog box may not reflect the entire set of print
options that are available from the printer driver; additionally, it does not indicate
which options require reRIPing of the job.

TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the Edit
menu.

The Override Print Settings dialog box appears.
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2. Choose the new settings from the pop-up menus.

If you select Default Settings, the job will use the settings in the Printer Specific
Options dialog box.

For information about these options, see the Printing Guide.

3. Click OK to make changes.
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Using the Job Log

With Fiery Spooler, you can view and print a log of all the jobs printed to the

Fiery ZX. You can also save the Job Log as a text file that you can then import into a
spreadsheet or word processing application for job accounting purposes. All jobs
printed to the queues, printed by direct connection, and scanned from the copier are
listed in the Job Log.

TO DISPLAY, UPDATE, PRINT, SAVE, AND DELETE THE JOB LOG:
1. Choose Show Job Log from the Window menu.

2. Specify the period for the Job Log in the window that appears.

Click All to view all jobs since the Job Log was cleared; click Date if you want to specify
a period of time for the Job Log.
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3. Click OK.

The Job Log window displays a list of all the jobs and the following information about
them: status, document name, user name, date, start time, end time, process time, file
size, print device, paper size, media, number of originals, number of color pages,
number of black and white pages, total number of pages, Notes 1, and Notes 2.

The information in the note fields is specified in the Print dialog box if you are using
the Adobe PostScript printer driver.

Use the scroll bar at the bottom of the window to view all fields in the Job Log
window.
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The text in the Status column provides information about the job:
OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You can
double-click ERROR to display the error message. A dialog box
displays the PostScript error. Click OK to close the dialog box.

CANCEL The job was canceled before printing was completed.

To update the Job Log, click the Update button at the top of the window.

To print the Job Log, choose Print Job Log from the File menu or click the Print button
at the top of the window.

The information displayed in the Job Log window prints to the current Fiery ZX.
When you print the Job Log, totals are printed for all appropriate columns.

To save the Job Log as a file that you can view with a different application, choose
Export Job Log from the File menu or click the Export button at the top of the window.
Enter a name for the log file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are
separated by tabs.

If you entered the Administrator password, you can choose Delete Job Log from the
File menu to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.



Chapter 6:
Color Calibration
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Introduction

Calibrating the Fiery ZX ensures consistent, reliable color output. You can calibrate the
Fiery ZX with the Fiery Print Calibrator and an X-Rite DTP32 automatic scanning
densitometer. By connecting the densitometer to the serial port on your computer, you
can quickly measure color patches and download measurements to the Fiery ZX.

You can also obtain measurements from the copier and apply a calibration using
AutoCal from the Fiery ZX Control Panel. AutoCal uses the copier’s built-in scanner
and does not require the use of a densitometer or the Fiery Print Calibrator.

This chapter describes the purpose of calibration and provides instructions for all
calibration procedures. Calibrating with the Fiery Print Calibrator is described first;
calibrating from the Fiery ZX Control Panel with AutoCal is described on page 6-20.

For information on advanced calibration and simulation features available with the
Fiery Print Calibrator, such as editing targets and creating custom targets, see
Chapter 7.

The Fiery Print Calibrator procedures described in these chapters are fundamentally
the same for Mac OS and Windows computers, including Windows NT 4.0
computers running Command WorkStation software. The main differences are the
interface cable and the port used to connect to the densitometer. The term computer is
used to refer to any computer running the Fiery Print Calibrator.

Introduction

A calibration is generated from two components that originate separately:
measurements and a target.

< Measurements represent the actual color behavior of the copier; they are computed
from densitometer readings.

« Targets represent the goal of printing, such as obtaining pleasing color from the
copier or simulating another print device. A copier-specific target is provided with
the Fiery ZX.
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Calibration generates curves describing the various color densities based on the target
and the measurements that you provide from a densitometer.

Once you have calibrated the Fiery ZX with the Fiery Print Calibrator, a calibration is
stored on the Fiery ZX; this calibration will be referred to as the resident calibration.
The resident calibration is applied to all print jobs unless bypassing of calibration is
specified by setting the CMYK Simulation option to Match Copy (see the Printing
Guide).

Note: Changing the resident calibration has the potential to affect all jobs for all users,
so you may want to limit the number of people authorized to perform calibration.An
Administrator password can be set to control access to calibration from the Fiery ZX
Control Panel. Administrator and Operator passwords can be set in Setup from the
Command WorkStation to control access to calibration with the Fiery Print Calibrator.

Understanding calibration

The Fiery ZX allows you the flexibility to choose a standard calibration or a custom
calibration. A standard calibration uses one of the targets provided with the Fiery ZX
(copier or Linear) with a new set of measurements.

Calibration allows you to:

« Maximize the color reproduction capabilities of the Fiery ZX
 Ensure consistent color quality across time

« Produce consistent output across Fiery ZX servers of the same engine

« Achieve better color matches when reproducing spot colors, such as PANTONE
colors or other named color systems

» Optimize the Fiery ZX for using ColorWise Color Rendering Dictionaries (CRDs)
and CMYK simulations, and for using ICC-compatible profiles when printing RGB
color data (see the Color Guide)

« Linearize the Fiery ZX while maintaining the currently available density range

Chapter 7 discusses advanced calibration techniques, including how to:
* Use the Fiery ZX as a proofing system by printing press simulations

« Create custom calibration and simulation targets
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How calibration works

Success in obtaining satisfactory print quality from a digital color printer depends on
many factors. Among the most important are establishing and maintaining optimal
toner densities. Density is a measure of the light absorbed by a surface. By carefully
regulating toner densities, you can obtain consistent printed color.

Even with a calibrated system, toner density is affected by such variables as room
humidity and service settings; it also tends to drift over time. Regular measurement
detects day-to-day variations in densities, and calibration corrects for them.

Calibration works by creating calibration curves on the Fiery ZX that compensate for
the difference between actual and desired density values.

Calibration curves and target curves are the graphic equivalent of transfer functions,
which are mathematical descriptions of changes that will be made to the data you start
with. Transfer functions are often graphed as Input/Output curves.

Target curves (targets, for short) result from applying one or more transfer functions in
sequence. The server generates calibration curves after comparing measured values to
the final target values for each of the four toner colors.

Measurements

Measurements files contain numerical values that correspond to the toner density
produced by the copier when it prints solid cyan, magenta, yellow, and black, and
graduated tints of those colors.

To create a measurements file, you first print a page of color patches from the Fiery
Print Calibrator or from the Control Panel to the copier. Then you measure the
patches, by using either an X-Rite DTP32 densitometer connected to a computer on
the network, or by using the copier’s scanner. The new measurements are automatically
downloaded to the Fiery ZX.

You can print a calibration Comparison Page showing the result of using the new
measurements with any of the current targets. When you are satisfied with a particular
combination of measurements and target, you apply the calibration to the Fiery ZX;
this becomes the new resident calibration.
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NoTe: You might also be able to create measurements with a different brand Status T
densitometer if the densitometer manufacturer provides utility software to create a
measurements file.

Targets

Target files define desired calibration results. Two target files are provided with the
Fiery ZX. You can create additional ones by modifying existing targets with the Fiery
Print Calibrator. When you calibrate the Fiery ZX, you can select the target file that
corresponds to the typical printing goals at your site. This becomes the resident
calibration target that is used by default.

The calibration targets provided with the Fiery ZX are:
e r2—Optimized for best results with the copier.

* Linear—Results in output that divides the maximum measured density for each
color into equal density steps to provide an even distribution of tones over the
copier’s density range. When you linearize the printer, the entire measured density
range in each color channel is divided into equal steps. Equal steps in toner
percentage, such as 0%, 10%, and 20%, are printed in equal steps in density, and
appear as roughly equal visual steps. This gives a linear response using the range of
densities available.

You can store targets on the computer where you use the Fiery Print Calibrator, on
another connected disk, or on the Fiery ZX disk (or all three).

Scheduling calibration

In general, you should calibrate the Fiery ZX at least once a day, depending on the
volume of print jobs. If it is very important to maintain consistent colors, or if the
copier is subject to wide fluctuations in temperature or humidity, calibrate every few
hours. Calibrate when you change paper stock. In general, to get the best performance
from the copier, calibrate whenever there is a noticeable change in print quality.

If you need to split a print job into two or more batches, it is especially important to
calibrate before printing each batch.
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You should also calibrate the Fiery ZX system after copier maintenance. However,
because the copier may be less stable immediately after maintenance, wait until you
have printed approximately 50 pages before you calibrate.

Note: Output from the copier is very sensitive to changes in temperature and
humidity. To minimize these effects, the copier should not be installed near a window
or in direct sunlight, or near a heater or air conditioner. Paper is sensitive to climate
changes as well, and should be stored in a cool, stable environment.

The copier has a self-calibration feature (Automatic Gradation Adjustment, or AGA)
that optimizes toner densities after scanning two test prints on the copier glass. The
copier has a self-calibration feature that optimizes toner densities. If you never calibrate
the Fiery ZX from the Fiery Print Calibrator or from the Control Panel, the self-
calibration feature can improve the color output of print jobs. Using the copier’s self-
calibration feature alone will not necessarily bring output densities from the copier to
the optimal values for Fiery ZX printing. However, if you regularly calibrate the

Fiery ZX, your print jobs can sometimes be improved by asking a service technician to
disable the copier’s self-calibration feature.

The copier allows you to adjust printed color from its touch panel display. You can
typically increase or decrease toner density for one or all toner colors. These control
panel settings affect copies made from the copier glass, and may affect Fiery ZX output
as well. If they do, make sure these settings remain the same (preferably at a neutral
position) prior to calibration, and from one print job to the next. If you change these
settings, calibrate the Fiery ZX when you have finished changing settings.

Print some standard color pages such as the Color Charts (from the Control Panel or
from the Command WorkStation) and the Color Reference pages included with the
user software (see Getting Started). All of these pages include fully saturated color
patches and pale tints of cyan, magenta, yellow, and black. Images with skin tones offer
a very good basis for comparison. You can save and compare pages you printed at
different times. If there is a noticeable change in appearance, you should calibrate or
linearize the Fiery ZX system.

If the solid density patches (100% cyan, magenta, yellow or black) look less saturated
with time, show the pages to the copier technician to find out whether adjusting the
copier can improve the output.
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Checking calibration status

You can check whether the Fiery ZX is calibrated, what target was used, and when the
printer was last calibrated. You can view information about the last calibration:

By printing a Configuration page or Test Page from the Control Panel or the
Command WorkStation.

< With the Fiery Print Calibrator, by choosing Server Status from the Server menu
(see page 6-11).

Using a densitometer

The Fiery Print Calibrator is designed to work with the X-Rite DTP32 reflection
densitometer so that color measurements are entered automatically.

Setting up the densitometer

Before you calibrate the Fiery ZX, you need to connect, configure, and calibrate the
densitometer to prepare for measuring the printed patches (see “Calibrating the
densitometer” on page 6-19). For additional information about setting up and using
the densitometer, see the documentation included with it.

TO CONNECT THE X-RITE DTP32 70 THE COMPUTER:
1. Turn off the computer.

2. Plug the square end of the interface cable (like a modular phone plug) into the 1/0
port on the side of the X-Rite DTP32.

Square connector
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3. Attach the connector to the computer.

For a Windows computer, attach the 9-pin connector to the COM1 or COM2 port on
the computer and tighten the screws.

Square connector

Unused connector

Connect to COM port

Interface cable

Connect to keyboard port

For a Mac OS computer, use the Macintosh interface cable to connect the 8-pin DIN
plug to the printer or modem port of the computer.

Connect the 4-pin DIN plug to an ADB port of the Mac OS computer.

Modem port

ADB port on Mac 0S
computer

Modem port
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4. Use the optional AC adapter (available from X-Rite) to provide power.

Plug the small connector on the adapter cable into the side of the X-Rite DTP32 and
plug the adapter into a wall outlet.

Small connector

AC adapter

Turn on the computer.
Calibrate the densitometer (see page 6-19).

Use the Fiery Print Calibrator to calibrate the Fiery ZX (see the next section).

Calibrating with Fiery Print Calibrator

The Fiery Print Calibrator allows you to calibrate from a computer networked to the
Fiery ZX. You can calibrate to targets provided with the Fiery ZX as described in this
chapter, or you can customize targets and calibration curves to suit the specific needs of
your printing environment as described in Chapter 7.

TO USE THE FIERY PRINT CALIBRATOR:

1. Start the Fiery Print Calibrator and connect to the server you want to calibrate.

To calibrate a different Fiery ZX, choose Open from the File menu.

For instructions on configuring the connection to the Fiery ZX from a Windows
computer, see Getting Started.
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2.

If this is the first time you are calibrating, you are prompted to select a target.

The first time you use the Fiery Print Calibrator, you see only the targets provided with
the Fiery ZX. You can store additional targets on the Fiery ZX and on your computer.
You can designate any target stored on the Fiery ZX as the resident target.

The initial default target is the copier target; it is the one with the copier device name

(r2).
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Select a target and click OK.

The target you choose becomes the default target. The target can be changed
independently of your measurements.

The Calibration Mode window

The Calibration Mode window of the Fiery Print Calibrator has large buttons which
indicate the sequence for the main Fiery Print Calibrator functions. There is a menu
bar with File, Edit, Measurements, Server, and Window menus, and a status message at
the bottom of the window. The functions that are unavailable at any particular time are
dimmed and cannot be selected.
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The buttons and their actions are:

« View Measurements—Displays a table of density values in the current measurements
file. Below the button is the date of the active measurements.

* Select Target—Allows you to select a new target for calibration or for customizing.
Below the button is the name and creation date of the currently selected target. This
target is not necessarily the resident calibration target used by the Fiery ZX.

* Edit Calibration—Allows you to view the current measured and target curves and
customize the selected target.

« Test Calibration—Prints a page so that you can view the results of calibration before
updating the resident calibration on the Fiery ZX.

 Apply Calibration—Updates the resident calibration on the Fiery ZX.

In order to Apply Calibration to the Fiery ZX, you must have a Measurements file
and a Target.
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To view current calibration information, choose Server Status from the Server menu.
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If the Fiery ZX is calibrated, the Server Status dialog displays the user name or login
name of the person who last calibrated the Fiery ZX, the name of the current

Fiery ZX, the date and time of the current measurement file, the name of the resident
calibration target, and the date and time of the most recent calibration.

Measurements

Measurements files provide toner values that correspond to standard color patches.
Typically, you measure a page of patches with a densitometer and the measurements
are loaded on the Fiery ZX.

The creation date and time of the current measurements file appears below the
Measurements button in the Calibration Mode window.

Note: For demonstration purposes only, if you do not have a measurements file,
you can use the DEMO.MEA file on the User Software CD. This file should not be used
to calibrate the Fiery ZX.
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Measuring values with a DTP32 densitometer

To create a measurements file you print a patch page and feed it into the densitometer.
The densitometer scans the density of the patches on the page and automatically
transmits the measured values to the Fiery Print Calibrator.

After each column of patches is scanned, you move the page to scan another column.
The DTP32 densitometer has an adjustable strip guide to the right of the strip
entrance. The density measurements are used to create a Measurements file. In general,
valid measurements for all patches fall within the range of 0 to 3.05. Values between
-0.01 and +0.005 are shown in the Fiery Print Calibrator as 0. Values that appear in
the Measurements window as negative numbers might indicate a problem with the
densitometer.

You can also print patches for calibrating in the copier’s Letter mode.

TO PRINT PATCHES FOR MEASUREMENT:

1.

From the Calibration Mode window, choose Print Patch Page from the Measurements
menu.

Select a page size and paper tray.

Letter/A4 prints 21 patches per color; 11x17/A3 prints 34 patches per color.

If you use the bypass tray, use thick paper.

The Fiery ZX downloads the patch page to the copier. The patch page has four
columns of progressively less saturated tints of each process color.

TO PRINT PATCHES FOR CALIBRATING IN THE COPIER'S LETTER MODE:

With Fiery Downloader, download either Letter21.ps (21 patches) or Letter34.ps
(34 patches) from the User Software CD.
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TO MEASURE CALIBRATION PATCHES WITH AN X-RITE DTP32:
1. Make sure your X-Rite DTP32 is connected (page 6-6) and calibrated (page 6-19).

2. Choose Densitometer from the Measurements menu.
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3. Select the page size that matches the patch page you printed.
The Long page size has more patches with more finely distinguished color gradations.

4. In the Select densitometer port pop-up menu, choose the port with the densitometer
interface cable.

If the densitometer screen does not display MAIN MENU, for example after calibrating
the densitometer, press the two MENU buttons at the same time.

5. Click Start.

6. Follow the on-screen instructions to measure patches.
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7.

8.

10.

11.

When prompted, position the pointer on the strip guide to 15.

The first column you'll measure is the cyan column.

With the arrow above the cyan column pointing towards the densitometer, align the
right side of the patch page with the strip guide.

Insert the patch page into the densitometer until it rests against the drive rollers and
the motor is activated.

There may be a slight hesitation before the rollers start.
Hold the page against the guide to prevent any skewing while the strip is being
measured.

After the strip is measured, Pass #1 of 1 OK! appears in the densitometer display.
Transmitting Data appears briefly after each pass.

When prompted (onscreen and on the densitometer), move the strip guide to 30 and
feed the patch page to measure the magenta column.

After the magenta strip is measured, Pass #1 of 1 OK! appears in the densitometer
display.
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12.

13.

14.

15.

Turn the patch page around so that the arrow above the yellow column is pointing
toward the densitometer.

Leave the strip guide set to 30.
When prompted, align the right side of the patch page with the strip guide and
measure the yellow column.

After the yellow strip is measured, Pass #1 of 1 OK! appears in the densitometer display.

When prompted, move the page guide to 15 and measure the black column.
After the black strip is measured, Pass #1 of 1 OK! appears in the densitometer display.

Norte: If there is a problem measuring a color, follow the instructions on the
densitometer to remeasure it.

When all four columns have been measured, click Accept in the Densitometer window.

The Densitometer window closes; the date beneath the Measurements button is
updated to the current date because the measurements have been saved to the
Fiery ZX.

TO SAVE THE

MEASUREMENTS FILE:

Choose Export from the Measurements menu to save the measurements file to your
computer hard disk.

If you save the measurements file to your hard disk, use it only as a backup for your
own reference. You can import this file later without having to remeasure, but this is
usually not recommended. For optimal calibration, use a new measurements file based
on current densitometer values.

For your information, exported measurements files are tab-delimited ASCI| files that
you can open in a word processing, spreadsheet, or database program.
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TO VIEW STORED MEASUREMENT VALUES:

Click the View Measurements button to view values in the current measurements file.
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Fiery Print Calibrator displays the current measurements on the Fiery ZX. They are
the measurements that were stored on the Fiery ZX when you last clicked Accept.

Testing and applying calibration

You can view a sample calibration before applying it to the Fiery ZX as the resident
calibration. Since the measurements have already been updated, you are actually
checking the combination of your measurements with one or more targets.

You can use the Comparison Page provided with the Fiery ZX to test a calibration
before applying it. This page shows a comparison of uncalibrated and calibrated data.

The Comparison Page provides the following calibration information:

RGB using Color Rendering Dictionary section
« Name—the name of the Fiery ZX defined in Setup

» Model—the Fiery ZX model name and copier model
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« Target—the currently selected target in Fiery Print Calibrator, not necessarily the
target for resident calibration on the Fiery ZX

» Measurements—how measurements were obtained
¢ Rendering Style—the default rendering style specified in Setup

* Date & Time—when the Comparison Page was printed

For a description of the information in the section of the page labeled “Press CMYK
using Simulation” see page 7-18.

You can also create your own comparison page. To do this, create a PostScript or an
EPS (Encapsulated PostScript) file and name it Calib.eps. Use the Fiery Downloader to
download the Calib.eps file to the Hold queue of the Fiery ZX.

TO TEST AND APPLY CALIBRATION:

1.

2.

Click Test Calibration in the Calibration Mode window.

Select a page, choose a paper tray, and click Print.
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If you are satisfied with colors on the printed page, click Apply Calibration, and click
Continue to update the resident calibration.

Alternatively, if you are not ready to apply the calibration, you can print a Comparison
Page with a different target or saved measurements file.

Select the target or measurements file, and click the Test button.
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4. When you have finished working with the Fiery Print Calibrator, choose Exit (Windows)

or Quit (Mac 0S) from the File menu.

Calibration checklist

Once you have calibrated the Fiery ZX and, if necessary, adjusted your target to get
satisfactory output, calibrating again is just a matter of taking new color measurements
and applying them to the current target. A summary of the steps follows.

Prepare the densitometer

Connect and configure the densitometer.

If color is critical, calibrate the densitometer. Otherwise, wait until the densitometer
prompts you to do so.

Use the Fiery Print Calibrator

Start the Fiery Print Calibrator.

Check the target indicated in the main window. This is your current target.

Choose Print Patch Page from the Measurements menu.

Choose Densitometer from the Measurements menu.

Choose the densitometer port and click Start.

Pick up the patch page from the copier and feed it into the densitometer, following the
prompts in the Densitometer dialog box on the Fiery Print Calibrator screen.

When you have measured all four colors, click Accept in the Densitometer dialog box.

Check the results
Click Test in the main window to print a calibration Test Page.

Compare the calibrated and uncalibrated color. If the result of using the new
measurements is satisfactory, click Apply Calibration. If not, either measure again or
edit the target, and test once more before clicking Apply Calibration.

Click OK in the confirmation dialog boxes and close the Fiery Print Calibrator.
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Calibrating the densitometer

You will need the black-and-white Auto-Cal strip included with the densitometer.
Calibrating the densitometer does not require the Fiery Print Calibrator.

TO CALIBRATE THE X-RITE DTP32:
1. Connect the densitometer to the computer and supply power (see page 6-6).

2. On the X-Rite DTP32, simultaneously press the two buttons marked MENU.
The words MAIN MENU appear in the display.

3. Press the pl key until p2 appears.

4. Press the cal key.
CALIBRATION appears in the display.

5. Press the den key.
CALIBRATING TRANSMISSION is displayed, followed by the words INSERT CAL STRIP.

6. Position the strip guide at 5.

Strip guide

7. Insert the arrow end of the Auto-Cal strip into the entrance of the X-Rite DTP32 until
the roller starts pulling the strip.

READING appears momentarily, followed by the density values and CALIBRATION OK.
If UNRECOGNIZABLE STRIP appears, try cleaning the strip (see the X-Rite DTP32
Operating Manual).

8. Start the Fiery Print Calibrator and proceed to calibrate the Fiery ZX (see page 6-12).

Recalibrate the densitometer at least once month. For critical color, calibrate the
densitometer every time you calibrate the Fiery ZX.
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Calibrating from the Control Panel

You can calibrate the Fiery ZX from the Control Panel using AutoCal, which calibrates
the Fiery ZX using the copier’s built-in scanner as a densitometer. If an Administrator
password has been set, you will need it for calibration.

For instructions on using the Fiery ZX Control Panel, and for more details on the
AutoCal options, see the Configuration Guide.

For information on error messages you may see during the AutoCal procedure, see
“AutoCal error messages” on page A-9.

Note: To calibrate using AutoCal, you will need the Kodak Gray Scale strip that came
in the media pack with your Fiery ZX.

TO ACCESS AND USE AUTOCAL:

1. Reboot the Fiery ZX, and be ready to press a button at the Control Panel shortly after
startup diagnostics.

2. Press any key when the Fiery ZX message “Press any key for setup...” appears.
3. Choose Calibration, and choose Set Up Calibration.
4. Choose AutoCal.

5. For Tray, choose the paper source for the patch page.

LTR/A4 prints 21 patches per color; 11x17/A3 prints 34 patches per color.
6. Choose Calibrate.

7. Specify AutoCal as the calibration method.

The Select Target screen appears.

8. Select the target.

You can choose from the list of all targets on the Fiery ZX. This includes the targets
included with the Fiery ZX and any custom targets you have created with Fiery Print
Calibrator.
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10.

11.

When prompted, select Yes to print the measurement page.

This page is comprised of swatches of color that will be measured by the copier and
then compared to the target color values.

After the page is printed, the Measure Page screen is displayed.
Select Yes in the Measure Page screen.

When prompted on the Control Panel, place the Kodak Gray Scale strip face down along
the top of the copier glass.

Place grayscale strip
face down

12.

13.

14.

15.

16.

17.

18.

/ //\ @ /\ Place color measurement page face
down over grayscale strip

Place the color measurement page face down over the grayscale strip.

Align the top-left corners of the grayscale strip and the color measurement page with
the arrow at the top-left corner of the copier glass.

Make sure the patches on the grayscale strip do not overlap the color patches.

Close the copier lid, being careful not to move the grayscale strip and color
measurement page.

Click OK.

Status messages display the progress of scanning and calculating measurements.

When prompted to Print Comparison Page, select Yes.

This page provides you with a preview of the selected calibration.
When prompted to overwrite calibration, select Yes.

Select Yes to confirm.

Status messages display progress information. The new calibration becomes the
resident calibration.

When calibration is complete, choose Exit Calibration.

This automatically restarts the Fiery ZX.
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Removing calibration

It is also possible to remove calibration from the Fiery ZX. In general, it is not
necessary because any new calibration replaces the existing one.

TO REMOVE CALIBRATION FROM THE CONTROL PANEL:
1. From the Control Panel, access the Calibration menu as described on page 6-20.
2. Choose Remove Calibration.

3. When prompted, verify that you want to proceed with removing calibration.

The current calibration curves are removed, and a default calibration is restored.



Chapter 7:
Advanced Fiery
Print Calibrator
Topics

7-1 | Using advanced calibration features

This chapter describes advanced features of the Fiery Print Calibrator, including
customizing calibration and simulation targets. For introductory information about
the Print Calibrator and for instructions on performing calibration, see Chapter 6. For
information on the simulation capabilities of the Fiery ZX, see the Color Guide.

The Fiery Print Calibrator procedures described in these chapters are fundamentally
the same for Mac OS and Windows computers, including Windows NT 4.0
computers running Command WorkStation software. The main differences are the
interface cable and the port used to connect to the densitometer. The term computer is
used to refer to any computer running the Fiery Print Calibrator.

The following section describes the advanced calibration features of the Fiery Print
Calibrator. For information on working with simulations, see “Using advanced
simulation features” on page 7-10.

Using advanced calibration features

The Fiery Print Calibrator offers additional flexibility for advanced users. You can:
* Use a different measurements file stored on your computer

« Select a different target when your printing goals change

« Edit an existing target to suit your needs, test it, save it as a custom target, and save it
on the Fiery ZX

* Save measurements as a target
 Back up the targets that are stored on the server

< Remove targets from the server

Choosing a measurements file

Although you can import a saved measurements file, the measurement file you use
should reflect the current color behavior of the copier. Therefore, import saved
measurements only if you have reason to doubt your current measurements, or if you
don't have access to a densitometer. You cannot edit measurement values with the Fiery
Print Calibrator.
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Note: The measurements file is copied to the server as soon as you load a new one. It is
also copied as soon as you accept new measurements in the Densitometer dialog box
(see Chapter 6).

Any measurement accepted or imported into the Fiery Print Calibrator automatically
becomes the measurements file for the connected Fiery ZX. This measurements file is
used to create the resident calibration as well as all the other calibrations stored on the
Fiery ZX.

Note: You should view or back up the current measurements before changing them.

TO USE A MEASUREMENTS FILE:

1.

To view the density values in the current measurements file, click the Measurements
button.

To back up the measurements, choose Export from the Measurements menu and enter
a descriptive name.

To use a different stored measurements file, choose Import from the Measurements
menu and select a saved measurements file from your computer.

Working with targets

Target files provided with the Fiery ZX contain desired calibration goals. Select the
target file that corresponds to the type of printing done at your site.

You can view your current measurements and compare them with the current target.
You can also edit the target file and save the changes as a new target file. This allows
you to fine-tune the calibration on the Fiery ZX to meet your exact specifications.

Custom targets are always based on an existing target. Select the target to use as a base
for the custom target on a target. In most cases, you'll use the copier target (r2).

The target for the resident calibration can be either of the provided targets, or a custom
target with any name. (Instructions for creating custom targets are provided later in
this chapter.) Select a target to use for the resident calibration, and click Apply
Calibration.



7-3 | Using advanced calibration features

You can test calibrations by comparing calibrated and uncalibrated image data on the
Comparison Page, which uses both CMYK and RGB images. You can also create a
custom comparison page as described on page 6-17.

Comparing the measured and target curves

Before editing a target curve, compare it to the current measured curve. By doing so,
you can determine how close the measured color densities are to the target densities.

The closer the measured densities are to the target densities, the better the results you
get from calibration.

Note: Large differences between the standard copier target and measured curves may
mean that the copier needs servicing.

TO COMPARE THE MEASURED CURVE AND THE CURRENT TARGET CURVE:

1.

2.

3.

Start the Fiery Print Calibrator and select a target from the list of available target
files.
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The targets in this list are stored on the Fiery ZX. Alternatively, click Local to use a
target stored on your computer.

Click OK.

Click the Edit Calibration button in the Calibration Mode window.
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4. Select Target/Measured and turn on the Measured option in the View Curves region.

These curves represent the values in the measurements file and cannot be changed.

Select Target/Measured

Turn on Measured

5. Turn on the Target option and compare the target curve (thick lines) to the measured
curve (thin lines).

Turn on Target




7-5 | Using advanced calibration features

Customizing calibration targets

The copier’s calibration target provided with the Fiery ZX should be used for general
printing purposes. You may, however, have special printing needs that require a custom
calibration. In this case, you can use the Fiery Print Calibrator to edit an existing
calibration target and save it as a custom target.

The Edit Calibration window provides information about your current target and
measurements in graphic form and lets you edit curves and values to create a new
target.

Note: All changes are stored as you make them. To discard changes, reload the target
from the server or your computer.
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The graph on the left side of the window allows you to view and manipulate color
output values. The View Channels check boxes (beneath the graph) and the View
Curves areas (to the right of the graph) specify the curves displayed on the graph.
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You can change several components of a target. The changes are accumulated in the
custom target that you eventually save. You can:

» Change the maximum density (Dmax).

An adjusted target is created with the new maximum density.

Independently, you can:

 Adjust brightness

* Adjust dot gain for more saturated output without affecting the overall color balance
« Load a custom curve and edit points in the curve

The current custom curve is applied to the original target curve or, if you adjusted
the Dmax, it is applied to the target with the new maximum density.

By clicking Save, save a copy of the edited target to your computer

« Choose Apply Calibration when you are ready to update the resident calibration on
the Fiery ZX

Note: The values in the following illustrations do not represent standard values. They
are intentionally exaggerated for example purposes.

TO ADJUST MAXIMUM DENSITY (DMAX):

1.

2.

Select the target to edit (see page 6-8).

Click the Edit Calibration button.

In the View Curves area, click Target/Measured and Target.

For each color, enter a value in the Maximum Density areas, and press Tab or Enter to
adjust the endpoint of the target curve as needed.

You can enter a value from 0.1 to 3.0.

The rest of the curve adjusts to make a smooth transition to the new endpoint. The
adjusted target is stored. To discard changes, reload the target from the server or from
the local disk.
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TO CUSTOMIZE A TARGET:

1.

2.

Select the target to edit (see page 6-8).
Click the Edit Calibration button.

In the View Curves area, click Custom to edit the input/output curve.

The graph maps input ink percentage to output ink percentage by analogy to ink on a
press. Initially, the graph is a 45° straight line; that is, input values equal output values.
This is the starting place for your editing.
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As you make changes, you either increase or decrease the amount of toner that will be
used to render a certain percentage tone. An ink density of 100% is a fully saturated
color; 0 to 5% is a highlight color.

In the View Channels area, select the channels to edit.

You can view information for all four colors at the same time (cyan, magenta, yellow,
and black), or any combination of these. Working with only one or two colors at a
time helps you to distinguish the curves and to fine-tune your adjustments, especially
when using a monochrome monitor.

In the “Apply setting to” menu, choose the channel to adjust in the
Lightness/Darkness area of the window.
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6. Use the Brightness menu to adjust brightness as needed.

7. Adjust the dot gain as needed.

These values are used independently of the Brightness curve. Changing the values for
dot gain can give more saturated color output without affecting the overall color
balance. The dot gain values simulate dot gain, not compensate for dot gain.

You can choose either the North American or European standard and then enter the
desired Dot Gain. The valid values for North American gain at 50% input are 0% to
50% output. The valid values for European at 40% input are 0% to 60% gain on
output; the valid values for European at 80% input are 0% to 20% gain on output.

If you use Dot Gain values, the curve will be smoothed so that there are no spikes or
jumps in output value.

Note: You should measure this value from actual press output, using a densitometer.

8. In the graph, drag points to adjust the curve as needed.

The graph maps input percentage to output percentage in 10% increments. Points
along the curve are marked so that you can adjust them.

Note: You should adjust points in this way after you have applied a brightness or dot
gain curve. If you attempt to change a brightness or dot gain setting after you have
adjusted the points on the graph, your earlier changes are not registered.
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9. You can test the changes now by using the Test Calibration button in the Calibration

10.

11.

Mode window, or customize the target further.

If you edit a local target file, you are prompted to save it on the Fiery ZX before
calibration can be changed.

Note: You cannot use the name of an existing target.

Enter a name for the edited target file and click Save.
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To save the target on your computer, click Save (in the Edit Calibration window) and
enter a name for the new target.

You can use a saved target again or continue editing it later.

Backing up Fiery ZX targets

If you think you may need a target later, you can back up targets to save the target to
your computer before you delete it from the Fiery ZX. You should always save targets
before updating Fiery ZX system software to ensure that no custom targets are lost.

TO BACK UP TARGETS:

Choose Back Up Targets from the Server menu.

This copies the target files from the Fiery ZX to your computer.
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Deleting custom targets

If desired, you can delete custom targets permanently from the Fiery ZX. You may
want to do this to make sure no one applies a calibration using the wrong target file.
You cannot delete the original targets (r2 and Linear).

TO DELETE CUSTOM TARGETS FROM THE FIERY ZX HARD DISK:

1.

2.

Start the Fiery Print Calibrator.
Choose Delete Target from the Server menu.

Select the target and click OK.

Note: Deleting the target used for the resident calibration does not affect the resident
calibration. To delete a calibration based on a deleted target, you must apply another
calibration that uses a different target, or remove calibration as described in the next
section.

Removing calibration

If desired, you can remove calibration from the Fiery ZX. When you remove
calibration, the resident calibration curves are removed, and a default calibration is
restored.

TO REMOVE CALIBRATION:

1.

2.

Choose Remove Calibration from the Server menu.

When prompted, confirm that you want to remove calibration.

Using advanced simulation features

The Fiery Print Calibrator offers simulation features for advanced users. You can:
« Change the default simulation on the Fiery ZX

« Edit an existing simulation to suit your needs, test it, save it as a custom simulation,
and save it on the Fiery ZX

« Back up the simulations that are stored on the server

+ Remove simulations from the server
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Working with simulations

Simulations, or press simulations, allow you to use the copier as a proofing device for
jobs that will print on an offset press. Because the range of colors available on the
copier is different from that of a press, the Fiery ZX automatically adjusts the color so
that the output falls within the range of colors a press can produce.

Several simulations are provided with the Fiery ZX, and you can create additional ones
by editing existing simulations with the Fiery Print Calibrator. A default simulation
target is specified by the administrator in Setup. You can change the default simulation
using the Fiery Print Calibrator.

The simulations provided with the Fiery ZX are:
« DIC—Japanese press standard

« Euroscale—European press standard

e SWOP-Coated—US press standard

 Match Copy—Bypasses calibration and produces output that matches a copy made
from the copier glass

Each of the press simulations has both a Quick and Full version. These versions
correspond to the method of mapping colors from your copier’s color gamut to that of
the desired press standard as follows:

* Quick—Compensates for only density (one-dimensional mapping)

* Full—Corrects for hue as well as density (four-dimensional mapping)

The PPD for the Fiery ZX provides placeholders for five custom simulations named
Custom-1, Custom-2, and so on. These can be made available for users to select from
the CMYK Simulation print option when printing a job.

You can store targets on the computer where you use the Fiery Print Calibrator, on
another connected disk, or on the Fiery ZX disk (or all three). However, only the
original simulations and five custom simulations are available to users who choose a
simulation on a job-by-job basis (with the CMYK Simulation print option).
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For a custom simulation intended to be available only asa CMYK Simulation setting
in Setup, any name can be used. For a custom simulation intended to be available for
users to choose on a job-by-job basis, the name must be “Custom-1”, “Custom-2”, and
S0 on.

Note: The custom simulation names “Custom-1" and “Custom-2” appear in the users’
CMYK Simulation settings, and users can choose them, whether or not the
corresponding custom options have been created and loaded on the Fiery ZX. Jobs
printed with a non-existent custom simulation fail printing and show an error.

For more information on the CMYK Simulation and CMYK Simulation Method
print options, see the Color Guide and the Printing Guide.

Using the Simulation Mode window

After starting the Fiery Print Calibrator, choose Simulation Mode from the File menu.

The Simulation Mode window has buttons for the most frequently used Fiery Print
Calibrator functions. There is also a menu bar with File, Edit, Measurements, Server,
and Window menus, and a status message at the bottom of the window. Functions
unavailable at any particular time are dimmed and cannot be selected.
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The buttons and their functions are:

* Select Simulation—Allows you to select a simulation to work with. You must select a
simulation before editing or applying it to the Fiery ZX. Below the button are the
name and creation date of the currently selected simulation, which is not necessarily
the default simulation on the Fiery ZX.
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« Edit Simulation—Allows you to view and customize the current simulation.

« Test Simulation—Prints a test page so that you can view the results of the simulation
you are currently working with.

« Set Default Simulation—Updates the default simulation on the Fiery ZX.

Checking the current simulation

You can use the Fiery Print Calibrator to see the simulation currently selected as the
default on the Fiery ZX.

TO VIEW INFORMATION ABOUT THE CURRENT SIMULATION:
1. Start the Fiery Print Calibrator and connect to the Fiery ZX.

2. Choose Server Status from the Server menu.
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The bottom section of the Server Status window displays the default simulation.
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Editing simulations

You can edit a press simulation to meet your exact specifications. You can also save the
changes as a new simulation.

Note: The values in the following illustrations do not represent standard values. They
are intentionally exaggerated for example purposes.

TO EDIT A SIMULATION:
1. Start the Fiery Print Calibrator and connect to the Fiery ZX.
2. Choose Simulation Mode from the File menu.

3. Click the Select Simulation button.
A dialog box displays the simulations available on the Fiery ZX.
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4. Select a simulation and click OK.

Click Local to select a simulation on your computer.
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5. Click the Edit Simulation button.
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You can use this dialog box to view or to edit simulations.

In the View Channels area, select the channels to edit.

You can view information for all four colors at the same time (cyan, magenta, yellow,
and black), or any combination of these. Working with only one or two colors at a
time helps you to distinguish the curves and to fine-tune your adjustments, especially
when using a monochrome monitor.

For each color, enter a value in the Maximum Density areas and then press Tab or Enter
to adjust the endpoint of the target curve as needed.
You can enter a value from 0.1 to 3.0.

The rest of the curve adjusts to make a smooth transition to the new endpoint. The
adjusted target is stored. To discard changes, reload the target from the server or from
the local disk.

From the “Apply setting to” menu, choose the channel to adjust in the
Lightness/Darkness area of the window.
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10.

11.

12.

Use the Brightness menu to adjust brightness as needed.

Note: If you change a value for a color with the Brightness menu, it overrides values
set elsewhere in the dialog box.

Adjust the Dot Gain value as needed.

For simulating press output, you can choose either the North American or European
standard. Enter the desired Dot Gain in the appropriate text box. The valid values for
North American gain at 50% input are 0%-50% output. The valid values for
European at 40% input are 0%-60% gain on output; the valid values for European at
80% input are 0%-20% gain on output.

If you use Dot Gain values, the curve is smoothed so that there are no spikes or jumps
in output value.

In the graph, click and drag points to adjust the curve as needed.

The graph maps input percentage to output percentage in 10% increments. The points
along the curve are marked so that you can adjust them.

Note: You should adjust points on the curves after you have entered values in the other
areas of the window. If you change values after you have adjusted the curve on the
graph, values might not be valid.

When you are finished, click Save and enter a name for the new simulation.

This saves the simulation to Fiery ZX. Use Local to save the simulation to your
computer hard disk so that you can use it again or continue editing it later.

« Give the simulation a new name. You cannot overwrite the name of an original press
target.

« Include part of the original name in the new name, for example, “SWOP-New.”
This helps you remember what the new simulation is based on.

« To allow users to print with the simulation on a job-by-job basis, you must use the
exact names “Custom-1”, “Custom-2”, and so on. Give users a description of the
custom simulations because they see only the “Custom” names from the printer
driver interface.

Norte: If custom simulations are later deleted from the server, users might still select
them when they print. However, jobs printed with non-existent custom simulations
will fail printing and report an error.
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Managing simulations

With Fiery Print Calibrator, you can back up and delete simulations. You can also set
the default simulation to None.

TO BACK UP SIMULATIONS:

Choose Backup Simulations from the Server menu to copy the simulations from the
Fiery ZX to your computer.

Simulations are saved in a folder called Backup in the folder where the Fiery Print
Calibrator is located. You can save simulations for safekeeping. You should always save
simulations before updating Fiery ZX system software to ensure that no custom
simulations are lost.

TO DELETE CUSTOM SIMULATIONS FROM THE FIERY ZX HARD DISK:

1.

2.

Choose Delete Simulation from the Server menu.

Select the custom simulation and click OK.

You can delete simulations to make sure no one uses the wrong simulation file. You
should always use the Backup Targets command to save simulations before you delete
them.

TO SET THE DEFAULT SIMULATION TO NONE:

1.

2.

Choose Set Default Simulation to None from the Server menu.

When prompted, confirm you want to reset the default.

Testing and setting a new default simulation

You can use the Comparison Page provided with the Fiery ZX to test a simulation
before making it the default simulation on the Fiery ZX. This page shows a
comparison of images with and without simulation applied.
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The Comparison Page provides the following simulation information:

Press CMYK using Simulation section

« Simulation—The currently selected simulation in Fiery Print Calibrator, not
necessarily the default simulation on the Fiery ZX.

» Method—Quick or Full. Quick accounts for only the density of colors (one-
dimensional mapping) to the press goal. Full corrects for both density and hue (a
four-dimensional mapping).

» Press—The press standard for which the sample CMYK images were separated (for
example, SWOP or Euroscale).

For a description of the information in the section of the page labeled “RGB using
Color Rendering Dictionary,” see page 6-16.

You can also create your own comparison page. To do this, create a PostScript or EPS
(Encapsulated PostScript) file and name it Calib.eps. Use the Fiery Downloader to
download the Calib.eps file to the Hold queue of the Fiery ZX.

TO TEST AND APPLY A SIMULATION:

1. In the Simulation Mode window, click Test Simulation.
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2. Select a page and choose a paper tray.
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3. Click Print.

4. When you have visually verified that the test page displays appropriate colors, click
Set Default Simulation.

5. Select the simulation to set as the default.

The default simulation is used when users select the Printer’s Default setting for the
CMYK Simulation print option. Users can choose a different simulation on a job-by-
job basis.






Appendix A:
Troubleshooting

A-1 | Error messages

This section lists error messages you might see, and provides some troubleshooting
guidelines should a problem arise with the Fiery ZX or the Command WorkStation. If
you are unable to resolve a problem after referring to this chapter, contact your
authorized service/support center.

Error messages

Error messages can result from problems with the print job, the Fiery ZX, the
Command WorksStation, or the copier. Some of the most common error conditions are
listed here.

A copier error message sometimes remains displayed on the Command WorkStation
even after you have resolved the error. A time lag in communicating the resolution of
the error to the Command WorkStation may lead you to believe the error has not been
resolved. However, printing will resume and the Command WorkStation display will
be updated after a short delay.

When an error interferes with printing, you will see a message at the Command
WorkStation. The status bar that displays the message indicates the process where the
error occurred. Following are the messages (listed in alphabetical order), with the
appropriate corrective action for each one. You can cancel the pending print job while
you attend to the error condition. A few normal status messages are included in this list
in case they cause concern.

Fiery ZX message: Corrective action/additional information:

Busy The Fiery ZX has received a print job, but the copier is being used
to make a copy. This message appears when someone makes a copy
without first selecting Suspend Printing from the Functions menu.
The Fiery ZX will begin the print job when the copy job is

finished.
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Fiery ZX message:

Corrective action/additional information:

Check power and cable

There is a problem with the copier power or cable connection.
First check to make sure that the copier is turned on. There may
also be a problem with the cable connection between the Fiery ZX
and the copier. Make sure that the cable has not come loose. The
Fiery ZX will resume printing when the cable is securely connected
to both the Fiery ZX and the copier.

Close bypass tray

The bypass tray is open. Printing will resume when the bypass tray
is closed.

Communication error

There is a communication error between the copier and the
Fiery ZX. Check the cable connections, and see the copier’s user
interface for additional information.

Copier offline

Someone has selected Suspend Printing from the Functions menu
on the Fiery ZX Control Panel, or has pressed F5 at the Command
WorkStation. When you select Resume Printing at the Control
Panel, or press F6 at the Command WorkStation, printing will
resume normally.

Door open

One of the copier doors is open. Printing will resume when the
door is closed.

Error-check panel

There is an unidentified problem with the copier. See the copier
user interface for additional messages. The copier will resume
printing when the problem is corrected.

in bypass tray

Load The copier is not loaded with the paper size specified. The

in any tray Fiery ZX will print when the copier is loaded with the required
paper.

Load _ The copier’s bypass tray is not loaded with the paper size specified.

The Fiery ZX will print when the bypass tray is loaded with the
required paper.

Load _ The copier’s Tray 1 is not loaded with the paper size or type

tray 1 specified. The Fiery ZX will print when Tray 1 is loaded with the
required paper.

Load _ The copier’s Tray 2 is not loaded with the paper size or type

tray 2 specified. The Fiery ZX will print when Tray 2 is loaded with the

required paper.
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Fiery ZX message:

Corrective action/additional information:

Load __ The copier’s Tray 3 is not loaded with the paper size or type

tray 3 specified. The Fiery ZX will print when Tray 3 is loaded with the
required paper.

Load __ The bypass tray is not loaded with the thick paper specified. The

thick in bypass tray

Fiery ZX will print when you have loaded the required thick paper
into the bypass tray.

Load _
trans in bypass tray

The bypass tray is not loaded with the transparencies specified.
The Fiery ZX will print when you have loaded the required
transparencies into the bypass tray.

No black toner

The black (K) toner has run out. Replenish the black toner
container according to the instructions in your copier manual.

No cyan toner

The cyan (C) toner has run out. Replenish the cyan toner
container according to the instructions in your copier manual.

No fuser oil

The fuser oil bottle in the fixing assembly is empty. Replace the
fuser oil according to the instructions in your copier manual. The
Fiery ZX will resume printing when you have replaced the fuser
oil.

No magenta toner

The magenta (M) toner has run out. Replenish the magenta toner
container according to the instructions in your copier manual.

No yellow toner

The yellow (Y) toner has run out. Replenish the yellow toner
container according to the instructions in your copier manual.

Paper jam There is a paper jam in the copier. Open the copier doors and
check the locations indicated on the copier display. The Fiery ZX
will resume printing when you have cleared the paper jam and
closed the copier doors.

Sorter limit ___ The sorter output bin is full. Printing will resume when the sorter

output bin is cleared.

Unknown error

An error occurred with the copier. See the copier user interface for
more information.

Warming Up

The copier is powering up. It will be ready for printing in a few
minutes.

Waste toner full

The copier’s waste toner container is full. Printing will resume
when you empty or replace the container.
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Maintaining optimal system performance

The Fiery ZX does not require maintenance. Beyond the routine requirements of
servicing and maintaining the print engine and replenishing consumables there are a
few things you can do to improve the overall performance of your system:

* Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because
several users are running utilities that are updated often. Large numbers of remote
users running the remote utilities or Fiery WebTools may have a significant effect on
Fiery ZX performance.

« Schedule the printing workload by checking job ticket information before printing.
Print jobs with the same output and paper specifications together to minimize paper
changes. Also, print routine jobs while you prepare to print jobs with special
instructions or special media.

 Reduce unnecessary server connections at the Command WorkStation. If you use a
second or third Fiery ZX server on an occasional basis, performance will be
improved if you log off when you are not using it.

« Avoid printing with the server Disk full warning.

If you see this warning, delete jobs from the Queues window that have been held for
a long time and are not likely to be needed. Avoid this condition by deleting old jobs
on a regular basis. The date associated with a job is the original date it was sent.

As a last resort, you can use the Clear Server or the Clear command.
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Troubleshooting

In case of problems, and before you call for service, check the guidelines in this section.
If you are unable to resolve the problem, make a note of the error condition and
contact your authorized service/support center.

Command WorkStation hangs

If the Command WorkStation windows do not update, try clicking the Log in/out
slider and logging out, and then exiting the Command WorkStation. Restart the
Command WorkStation application or restart the computer.

If the Command WorkStation windows do not update, or no jobs are displayed, and
the mouse has no effect (you cannot select a job or a window, use a right mouse
command, or select a menu item) the Fiery ZX is down or communication over the
network has failed.

To force an exit from the Command WorkStation application, press Ctrl-Alt-Delete,
and with the Command WorkStation selected, click End Task. At the Fiery ZX,
disconnect and reconnect the network cable, and try printing a Test Page or
Configuration page. If that fails, reboot the server.

If the Fiery ZX Control Panel does not respond to the Menu button, press the Reset
button, turn off the server and turn it on again. When it reaches Idle, restart the
Command WorkStation application.

Command WorkStation fails to connect to a Fiery ZX

If a remote Command WorkStation cannot connect to a server that was connected
previously, you may need to reconfigure the connection.

1. If you can, choose Exit from the Command WorkStation File menu.

2. In the C:\Windows folder, find the Efinl.ini file and move it out of the C:\Windows
folder to another folder.

If the EfinlLini file contains a limited amount of configuration information that is easily
recreated (i.e., information for only one or two servers), you can delete the file
altogether. A new Efinl.ini file will be created in the C:\Windows folder when you
reconfigure the connection.
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If the Efinl.ini file contains configuration information for several servers, or
information that is not readily recreated, keep the Efinl.ini file as a backup.

3. Print a Configuration page.

You will use the information on this page to configure the connection to the server.

4. Launch the Command WorkStation application.

5. When you are prompted to co

Use the instructions in Gettin

6. If you still cannot connect to

nfigure a server connection, click OK.

g Started to configure the connection.

the Fiery ZX, the administrator should reinstall

Command WorkStation software.

See Getting Started for details.

Unexpected printing results

If this happens:

This is the problem:

A cover page is not printed
when you reprint a saved
raster job.

The cover page identifies the originator of the job and the
time the job was sent. Time stamp and user information on
the cover page of a reprinted job are not meaningful.

The job settings are not
carried out as you expected.

If the user printed from the Mac OS or Windows 3.1x
platform, there may be two conflicting print settings. You can
check the job properties by double-clicking the job. See the
Printing Guide for a table of job properties and conflicting
properties. Notify the users of these conflicts so they can
avoid them in the future.

The job doesn't print.

Some printing errors may be displayed in the Print status bar.
When the job is in the Printed queue, jobs that had a
PostScript error are displayed in a light red job row. Double-
click anywhere in the row to see the error message.
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If this happens: This is the problem:

There are font errors. If user-specified fonts that are not resident on the Fiery ZX
are not printing correctly in PostScript files that are
downloaded by users, request that they embed the fonts in
the PostScript file or print directly from their application.
When users print from their applications, if special fonts are
not downloaded automatically, they should be downloaded
directly to the Fiery ZX with the Fiery Downloader. This can
be done by the user or by the operator, provided the Direct
connection is enabled. For information about the Fiery
Downloader, see the Printing Guide.

Clearing the server

Clearing the server is an Administrator option that can be used as a last resort if a job
persists in the system and prevents printing despite attempts to cancel or delete it.
Clearing the server deletes all jobs currently saved on the server in any queue. It also
clears the Job Log.

Before clearing the server, export the Job Log if you haven't recorded the information
in it. If you can, notify users that you will clear their jobs from the server so they can
back them up and resend them when the server is back in operation.

You can clear the server from the Control Panel (see page 1-7) or from the Command
WorkStation with the Clear command in the Server menu (See page 2-9).

Users are unable to connect to the printer

If users are unable to connect to the printer, or are unable to find the printer from their
workstations, the network administrator may need to troubleshoot their network
connections, and check settings on the servers they use for printing. If settings have
changed, it may be necessary to reconfigure the Fiery ZX.

For example, if print servers or print queues on a Novell server are renamed or deleted,
or if accounts or permissions are changed, the Fiery ZX administrator may have to edit
settings or enter new settings in IPX (Novell) Setup to reflect the new configuration.
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If users cannot connect to the printer with the Fiery Downloader from Windows 95 or
Windows NT 4.0, you may need to reconfigure the utility’s connection to the server.
See Getting Started for details.

Mac OS users may fail to see the printer if a network administrator has assigned it to a
different zone, or has added zones where previously there were none.

If you have configured the Fiery ZX and set up client computers and network servers
according to guidelines in the Configuration Guide and Getting Started, try printing a
Test Page (at the Command WorkStation, choose Print Pages from the File menu).

If you are able to print the test page but still can’t print a file from a remote computer,
contact the system administrator to troubleshoot the network connection.

If you are unable to connect, and you cannot print the Test Page, check the copier’s
touch panel display.

If this happens: Try this:
It displays a diagnostic or Take the appropriate corrective action, as described in the
error message. copier manual or in the section “Error messages” on
page A-1.
The display is completely Check the copier’s Standby function. If the copier is in
blank. Standby mode, press the Standby key to see any messages on
the display.
The copier is not in The copier’s Automatic Power-Off function may have shut
Standby mode. down the copier.

Turn the copier on, and then try printing a Test Page again
when the copier has warmed up.

You still cannot print a Make a copy. If you can make a copy, restart the Fiery ZX,
Test Page. and when you see Idle on the status line of the Fiery ZX
display, try printing a Test Page again. If the Test Page still
fails to print, contact your authorized service/support center.
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Setup error messages
For information on Setup error messages, see the Configuration Guide.

AutoCal error messages
AutoCal error messages can result from problems during the AutoCal procedure.

Fiery ZX message: Additional information:
Error 5 The calibration file cannot be opened.
Error 6 The calibration file was not read correctly.
Error 8 The measurement page did not scan properly, either because it is

crooked or the data is corrupted.

Error 11 The color strips on the measurement page are inconsistent.
Error 12 The copier model being used is not supported.
Error 20 The measurement page cannot be scanned because the dots per

inch (dpi) are incorrect.

Error 102 The grayscale strip is crooked or is positioned incorrectly.

Error 103 The grayscale strip is positioned too far to the left or to the right of
the measurement page.

Error 104 The grayscale strip is positioned too far above the measurement
page.

Error 111 The grayscale strip could not be found; either reposition the strip

correctly or position it vertically.







Numerics

4-pin DIN 6-7
8-pin DIN plug 6-7
9-pin connector 6-7

A
access

levels xvii, 2-5

restricting xvii
active jobs 2-18
adjusting columns (Queues window) 2-14
Administrator password xvii, 1-6, 2-1, 2-5
Adobe Photoshop, see Photoshop
AGA, see calibration
Alert Status screen 1-3
animation, see status bars
Apply Calibration option 6-10, 6-17
AutoCal calibration 6-20, 6-21, 6-22
Automatic Gradation Adjustment, see

calibration--AGA

B

Backup Simulations option 7-17

Back Up Targets option 7-9

brightness, adjusting in custom curves 7-8
Brightness menu 7-16

broken LCD xviii

buttons, Control Panel 1-2

C
CALIB.EPS file 6-17, 7-18
Calibrate command 2-11, 3-23
calibration
adjusting brightness 7-8
AGA (copiers self-calibration) 6-5
applying 6-17
bypassing 7-11
checking status 6-6

checklist 6-18
COM1 and COM2 port 6-7
Comparison page 6-16, 7-18
current 6-2
custom curves 7-7
editing 7-2 to 7-9, 7-14
expert features 7-1to 7-19
from the Control Panel 6-2, 6-20, 6-21,
6-22
from the Fiery Print Calibrator 6-2
measurements 6-1, 6-2, 6-3
measurement values 6-12 to 6-16
measuring patches 6-13
overview 6-1, 6-2, 6-3
port 6-13
removing 7-10
resident 6-2, 7-2
scheduling 6-4
self-calibration 6-5
standard procedure 6-6 to 6-18
targets 6-1, 6-2, 6-3, 6-9
testing 6-16, 6-18, 7-9, 7-18
viewing status 6-11
see also densitometer, Fiery Print
Calibrator
Calibration Mode window 6-10
Calibration option 1-7
calibration patch page 6-3, 6-12
Cancel Job
from the Control Panel during
printing 1-3
from the Control Panel during
RIPping 1-3
Cancel Printing command 2-11, 3-6
Cancel RIPping command 2-11, 3-6
Change (Administrator) Password
option 1-7
Clear (Server) command 2-11
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Index

Clear command 3-23
Clear Server command 1-7
CMYK Simulation option 7-11, 7-12
Color Charts 1-5, 3-3, 6-5
Color Reference pages 6-5
color server
cleaning xviii
clearing the A-7
configuring 2-3
connecting from Command
WorkStation 2-3, 2-12
display window xviii
restarting 1-7
selecting another 2-12
shutting down 1-8
Color Setup option 1-7
column width, adjusting 2-14
Command WorkStation xiii
display, described 2-6
introduction to 2-1
Job Log window 2-26
logging in to server 2-4
main window 2-6
menus 2-9
Queues window 2-6
starting 2-3
troubleshooting A-5, A-6
Comparison Page 6-16, 7-17, 7-18
calibration 6-3
custom 6-17, 7-18
Configuration page 6-6, A-6
printing from the Command
WorkStation 3-3
printing from the Control Panel 1-5
Confirm file deletion option 5-17
connection to server, configuring 2-3
Control Panel 1-1to 1-8
activity light 1-2, 1-4
buttons 1-2
calibration from 6-2
down button 1-2
Functions menu 1-5

line selection buttons 1-2

Menu button 1-2

removing calibration 6-22

status screens 1-3

up button 1-2
Control Panel Map

printing from the Command

WorksStation 3-3

printing from the Control Panel 1-5
copier, adjusting printed color from 6-5
curves

Brightness 7-8

input/output 7-7

target 7-8
custom Comparison page 6-17, 7-18
custom simulations 7-11

D
Delete command 2-10, 2-22, 3-10
Delete Job command (Fiery
WebSpooler) 5-5
Delete Simulation option 7-17
DEMO.MEA file 6-11
densitometer
calibrating 6-19
DTP32 6-1, 6-6 to 6-8, 6-12, 6-19
for calibration 6-20
selecting port 6-13
Status T densitometer 6-4
Densitometer window 6-15
density patches 6-5
DIC simulation 7-11
differences
between DocBuilder for Fiery
WebSpooler and for the
CommandWorkStation 5-8
between Fiery Spooler for Windows and
Fiery WebSpooler 5-12
Direct connection 2-20, 3-20, A-7
disk space used 2-13
display window 1-3
Dmax, see maximum density
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DocBuilder 3-9 to 3-14
Delete command 3-10
Duplicate command 3-10
editing options 3-10
merging two files 3-12
Open Preview command 3-10
Undo command 3-10
DocBuilder differences 5-8
Dot Gain
adjusting 7-16
European standard 7-16
North American standard 7-16
simulating 7-8
down button 1-2
Download command 2-10, 2-24, 3-20
downloading files and fonts 3-16
Duplicate (page) command 3-10
Duplicate command 2-10
Duplicate Job command (Fiery
WebSpooler) 5-5

E

Edit Calibration options 6-10

Edit Calibration window 7-5

Edit Simulation button 7-15

Edit Simulation options 7-13

Efinl.ini file A-5

Enable Popup Help option 2-9

error display 2-17

error messages A-1to A-4
during Setup A-9

Euroscale simulation 7-11

Exit command 2-9

Exit Setup option 1-7

Expand/Collapse All command 2-9

Export command 6-15

F

Fiery Print Calibrator 6-1, 6-2
advanced features 7-1to 7-19
calibration from 6-2
Calibration Mode window 6-9

checking calibration status 6-6
displaying measurements 6-16
function buttons 6-10, 7-12
main window 6-9

overview 6-8 to 6-18

press simulations 7-13
Simulation Mode window 7-12
storing targets 6-4

Fiery Spooler

changing print settings 5-19
deleting jobs 5-19
duplicating jobs 5-18
moving jobs 5-19

Fiery WebSpooler

accessing 5-2

Delete Job(s) command 5-5
functions available with 5-2
Guest (view-only) privileges 5-2
Hold command 5-5

Job menu 5-4, 5-5

Operator password 5-2
overview 4-2

Print and Hold command 5-5
Print command 5-5

Process Next command 5-5
raster data 5-5

Remove Raster command 5-5
Rename command 5-5

RIP and Hold command 5-5
RIPped jobs 5-3

status bars 5-3

window 5-3

Fiery WebTools

accessing 4-3
home page 4-3
Installer 4-2
overview 4-1
passwords 4-1
Status 4-2
WebLink 4-2
WebSpooler 4-2

File menu commands 2-9
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Index

fonts
deleting 3-21
displaying font list 3-21
downloading 3-17, 3-21, A-7
managing 3-20 to 3-21
printer fonts on server 1-5, 3-21
printing font list 1-5, 3-3, 3-21
Functions menu, Control Panel 1-4, 1-5

G

Guest access xvii, 2-1, 2-5

H
headers
Job Log window 2-25
Queues window 2-14, 3-2
held jobs 2-18, 2-20
Help menu commands 2-11
Hold command 2-10, 2-23, 5-5
Hold queue 5-13

|
icons
Job Log window 2-26
Print area 2-21
RIP area 2-20
Spool area 2-19
Info Status screen 1-4
Installer WebTool, see Fiery WebTools

J

job
active 2-18
areas 2-3
canceling 3-6
defined xv
deleting 2-22
deleting in Fiery Spooler 5-19
duplicating 5-18
environment xvi
flow 2-15

flow diagram 2-18
flow scenarios 3-4
held 2-18
limit 2-21, 2-22
order of display 2-18
overrides 3-15, 5-6
previewing 3-10
remove raster and reRIP 2-21
job icons 5-3
Print area 2-21
RIP area 2-20
Spool area 2-19
Job Log 2-26
clearing 2-26, 3-21
deleting 2-26, 3-21
described 2-25
displaying 3-21, 5-9
exporting to a file 2-26, 3-21
printing automatically 2-27
printing from the Command
WorkStation 3-3, 3-21
printing from the Control Panel 1-5,
3-3
specifying a date range 2-25
updating the display 2-26, 3-21
using (from Fiery Spooler) 5-21
using (from Fiery WebSpooler) 5-8
viewing printed jobs 5-4
Job Log Setup option 1-7
Job menu commands 2-10, 5-4
Jobs Saved in Printed Queue 2-22
job ticket information 3-2, A-4
rearranging 2-14, 3-2

L

LCD xviii, 1-1

line selection buttons 1-2
logging in to a server 2-4

Log infout slider 2-4, 2-13, A-5
Log out command 2-11
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M
Mac OS

ADB port 6-7

interface cable 6-7
Manage Fonts command 2-11, 3-20, 3-23
Match Copy simulation 6-2, 7-11
maximum density 7-6, 7-15
Maximum Density area 7-15
measured curve, viewing 7-7
measurements file 6-3, 6-11

creating 6-12 to 6-16

file format of 6-15

saving 6-15

view 6-10
Menu button 1-2
messages, See error messages

N
Network Setup option 1-7
Notes fields 3-1

in Job Log 5-21

0
on/off switch 1-6

Open Preview command 3-10
Operator password xvii, 2-5, 4-1, 5-2

Override Print Settings command 5-5, 5-19

P
PANTONE 1-5, 3-3
passwords
Administrator 2-5
Change (Administrator) Password
option 1-7
for calibration 6-2
for Command WorkStation access 2-1
Operator 2-5, 4-1, 5-2
patch page 6-12, 6-13, 6-15
PDF files, downloading 3-18
performance, optimizing A-4
permissions xvii, 2-1
Photoshop, transfer functions 3-20

port, densitometer 6-13
PostScript xv, 2-15
error 2-21
icon 2-19
RIP xv
PostScript Setup option, see PS Setup option
power switch 1-6
Preferences menu command 2-9
press simulations, see simulations
Preview command 2-10
previewing print jobs 3-8
Print and Hold command 2-10, 2-23, 5-5
Print area 2-3
icons 2-21
Print command 2-10, 2-23, 5-5
Printed queue 2-3, 2-21, 5-3, 5-13
printer (job) icon 2-19
printer fonts, see fonts
printer settings, customizing 2-10
Printer Setup option 1-7
printing 2-16
Comparison page (calibration) 6-16
Comparison page (simulation) 7-17
Configuration page 1-5, 3-3
defined xv
font list 1-5, 3-3
server information pages 1-5, 3-3
print jobs
deleting from queue 2-10
previewing 3-7, 3-8
routing 2-22 to 2-24
Print Pages command 1-5, 2-9, 3-3, 3-21
Command WorksStation 3-3
Control Panel 1-5
Print Patch Page option 6-12, 6-13, 6-15
Print queue 5-13
Print Status screen 1-3
problems, see troubleshooting
Process Next command 2-10, 2-23, 5-5
Properties command 2-10, 2-23, 3-15
Properties dialog box 3-14
PS Setup option 1-7
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Q

queues 2-15

Queues window 2-6, 2-15
changing the proportions 2-17
deleting held jobs A-4
described 2-15
elements 2-6
spooled jobs 2-15

R
RAM 2-16
inuse 2-13
total 2-13
raster
data 2-20, 2-22, 5-5
icon 2-19
image 2-16
needed for DocBuilder 3-9
raster files
editing 3-9
previewing 3-7
saving 2-16
saving an edited document 3-11, 3-14
rasterizing, see RIPping
Reboot (Server) command 2-11, 3-23
Reboot Server command, from Control
Panel 1-5
remote users A-4, A-7
Remove Calibration option 7-10
Remove Raster command 2-10, 2-23, 5-5
Rename command 2-10, 2-23, 5-5
resident calibration 6-2
applying 6-17
bypassing 6-2
restricting access to server xvii
Resume Printing command 2-11
Control Panel 1-5
Revert to Defaults command 2-9

right mouse button commands 2-22 to 2-24

RIP, defined xv
RIP and Hold command 2-10, 2-23, 5-5

RIP area 2-3, 2-20

RIPped jobs 2-3, 5-3

RIPping 2-15

RIP Status screen 1-3

Run Diagnostics command 1-5

S
safety xviii
Save Target option 7-9
scanning 3-6
Select Simulation button 7-12, 7-14
Select Target option 6-10
server fonts, see fonts
Server Information slider 2-13
Server menu commands 2-11
Server Selection tabs 2-12
Server Setup option 1-7
Server Status option 6-6, 6-11
Server Status window 7-13
Set Default Simulation button 7-13
Setup command 2-11, 3-23
‘showpage’ after EPS files option 3-19
Simulation Mode window 7-12, 7-13
simulations

applying 7-18

backing up 7-17

Comparison Page 7-17

custom 7-11

deleting 7-17

editing 7-14

Full method 7-18

overview 7-11

Quick method 7-18

removing 7-17

saving 7-16

selecting 7-14

testing 7-17, 7-18

viewing 7-14
sliders 2-12
source file 3-9
spool, defined xv
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Spool area 2-3
job icons 2-19
spooled jobs 2-3
displayed in Fiery WebSpooler 5-4
icons 2-19
Spooler, see Fiery Spooler
starting the server 1-6
status bars 2-2, 2-16
animation 2-17
displaying error 2-17
Print 5-3
RIP 5-3
Spool 5-3
status screens, Control Panel 1-3
Status WebTool, see Fiery WebTools
Suspend Printing command
from Command WorkStation 2-11
from Control Panel 1-5
switching servers 2-12
SWOP-Coated simulation 7-11
system information 2-12
system performance A-4

T
target file 3-9
targets 6-3

backing up 7-9

copier target 6-4

curves 7-4

custom 7-5to 7-6, 7-7

Linear 6-4

measured curves 7-4

provided with the color server 6-4

removing 7-10

saving 7-9

viewing and editing 7-7

working with 7-2

see also calibration and simulations
Test Calibration option 6-10
Test Page 6-6

printing A-8

printing from

Command WorkStation 3-3

printing from Control Panel 1-5
problem printing A-8
Test Simulation button 7-13, 7-18
Thumbnail A
editing options 3-10
page commands 3-9
page display 3-7
window 3-9
Thumbnail A command 2-10, 2-23, 5-6
Thumbnail B
window 3-9
Thumbnail B command 2-10, 2-24, 5-6
transfer functions 6-3
troubleshooting
Command WorkStation cannot connect
to server A-5, A-6
Command WorkStation hangs A-5
general guidelines A-5
unexpected printing results A-6, A-7
users are unable to connect to the
printer A-7

U

undo, in editing thumbnail views 2-30, 3-13
Undo command 2-10, 3-10

up button 1-2

utilities, remote A-4

Vv

View Channels area 7-15

View Measurement icon 6-16
View Measurements option 6-10

W
warning

display window breakage xviii
WebLink WebTool, see Fiery WebTools
WebSpooler, see Fiery WebSpooler
WebTools, see Fiery WebTools
window selection tabs 2-6, 2-15
workflow scenarios 3-4
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